
NeoSoft

Serba Gratis!Serba Gratis!
Jika anda cukup rajin
berselancar di dunia maya
belakangan ini barangkali
anda akan mendapati
bahwa yang namanya
program gratisan alias
freebies atawa freeware

bukan lagi hanya program-program kecil
semacamprogram utilitas. Program ‘besar’
yang biasanya harus anda beli pun kini
banyak dijumpai di Internet. Dan asiknya,
anda bisa mengambilnya gratis dengan cara
men-download-nya.

Pembaca NeoTek tidak perlu bingung karena
harus men-download program sebesar 47,4
Mb (Open Office) karena kami menyediakannya
untuk anda dalam CD NeoTek bulan ini. Selain
Open Office, anda juga dapat menjumpai  tiga
office suite lain yaitu Ability Office, 602Suite 2001,

dan Easy Office, plus beberapa
program tambahan lain yang
juga pasti berguna untuk anda
seperti 602Pro Print yang dapat
digunakan untuk membuat file-
file PDF dan OpenUSS, sebuah
program administrasi pendi-
dikan yang banyak dicari orang.

GIMP for Windows

NeoSoft kali ini mencoba
mengetengahkan satu program
grafik yang juga freeware yakni
GIMP (GNU Image Manipulat-
ion). Program yang bersala dari

lingkungan Linux ini sekarang, berkat upaya Tor
Lilquist, telah tersedia versi Windows-nya sehingga
anda, para pengguna Windows, dapat mengguna-
kannya untuk bekerja di Windows.

Apakah GIMP Itu?

GIMP adalah perangkat lunak yang dapat
digunakan untuk pekerjaan semacam retouching
foto, komposisi image, dan manipulasi gambar.
Program ini dapat disetarakan dengan Photoshop
di Windows. Pada contoh di bawah, misalnya, anda
dapat melihat hasil manipulasi yang dilakukan
pengguna GIMP di Windows seperti yang dapat
anda jumpai pada situs WinGimp dengan alamat di
http://www.wingimp.org/tutorial/.

• Gambar di atas adalah salah satu tampilan GIMP for Windows
dengan beberapa jendela terpisah yang dapat dibuka dan ditutup
oleh pengguna sesuai dengan keperluan.

• Gambar di bawah menunjukkan salah satu efek yang dapat anda
temukan pada GIMP. Teknik ini memungkinkan anda membuat efek
seperti pada perangko tua atau gambar pada uang kertas.



Juni 2002 NeoTek 1

HomePage

NNEOEOTETEKK
D

ar
ip

ad
a 

an
d

a 
m

en
-

D
ar

ip
ad

a 
an

d
a 

m
en

- d
ow

n
lo

a
d

d
ow

n
lo

a
d

......
Pendamping Berselancar Salam!Salam!

hat, seperti juga obrolan, tidak akan habis diperbin-
cangkan. Bisa berpanjang-panjang tanpa ujung dan
isi, tetapi bisa juga ringkas-ringkas namun berisi dan

bermanfaat. NeoTek memilih yang kedua. Nomor ini
membahas chat tanpa terlalu berpanjang-panjang melainkan
menyodorkan manfaat. Pembahasan bukan lagi sekitar apa itu
chat, tetapi menjorok lebih jauh. Mulai dari membuat teks
berwarna pada saat chat, membuat skrip untuk mIRC, sampai
melindungi channel dengan bot bernama Eggdrop. Silakan
membaca dan mempraktikkannya di ruang obrolan maya
anda.

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

TTahu lebih jauh perihal ahu lebih jauh perihal chatchat
ngobrolngobrol tidak jadi ttidak jadi tergencetergencet

CC

• Mr P Script yang bisa di-download dari Internet adalah skrip untuk chat di server
Dalnet. Skrip buatan putra Indonesia ini mempunyai banyak fitur yang berguna untuk
chat, selain itu mudah instalasi dan penggunaannya.

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• Anti Klez
• Fix CIH
• EZFTP
• Camouflage
• Text Encrypter 5
• Zero PopUp 1.38
• JavaScript Editor 2.5
• Coffee View 2.5
• Blender 2.23
• System Safe Setup
• ShockWave Full
• Virtual Game Station

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp19.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan

www.neotek.co.id

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

CHATROOM DI DALNET
#neoteker

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 506
Jl. Palmerah Utara III No. 9
Jakarta 11480

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

PENAWARAN KHUSUS
Dapatkan koleksi 8 CD NeoTek

- CD NEOTEK 2-1
- CD NEOTEK 2-2
- CD NEOTEK 2-3
- CD NEOTEK 2-4
- CD NEOTEK 2-5
- CD NEOTEK 2-6
- CD NEOTEK 2-7
- CD NEOTEK 2-8

Dengan harga Rp95.000,-
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Daftar Isi

Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 9I No. 9
NeoStyleNeoStyle NeoTNeoTeknoekno

Warna di Chat Room
Bagaimana membuat teks
berwarna ketika chat?

7 Modifikasi Game
dengan Blitz Basic
Mengubah game dengan Blitz

Basic sehingga dapat lebih interaktif.

41

Mengatur mIRC
Men-set fitur-fitur pada mIRC
agar sesuai dengan keperluan

anda.

8

Acces Point WLAN
Bagaimana men-set Access
Point pada Wireless LAN.

26

3D Flash Animator 1
Kenali fitur-fitur program
pembuat animasi 3D ini.

IDLN, Perpus Online
Akses beberapa perpustakaan
universitas di Indonesia secara

online sehingga lebih praktis.

44

15

OpenUSS
Software administrasi pendi-
dikan kelas dunia kini tersedia

dari dunia open source.

14

3D Flash Animator 2
Praktik pembuatan animasi 3D
dengan 3D Flash Animator.

46

Klien WLAN
Praktik penyetelan klien Wire-
less LAN bernama Compex.

28

TCP/IP Header
Pengenalan TCP/IP header
perlu bagi para calon hacker.

29

Bermain Skrip mIRC
Skrip dapat menambah bebe-
rapa fungsi pada program

mIRC. Inilah mr P script yang buatan
putra Indonesia.

10

Emulator PS
Gunakan emulator konsol
PlayStation agar anda dapat

memainkan game konsol ini di
komputer anda.

Situs NeoTek www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
HumanClick
Hotline langsung ke redaksi NeoTek
untuk menyampaikan saran dan pesan.
Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker
Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

NeoEduNeoEdu

NeoGameNeoGame
48



NeoTNeoTutorutor

ASP: Buku Tamu
Cara membuat buku tamu pada
halamana Web anda dengan

menggunakan ASP.

21 Proteksi Sederhana
Cara sederhana upaya proteksi
terhadap folder.

40

JavaScript: Tipe Data
dan Variabel
Tutorial  mengenai macam-

macam tipe data dan variabel pada
JavaScript disertai dengan contoh-contoh
skripnya.

18

Instalasi Folder Guard
Gunakan Folder Guard untuk
melindungi folder file di

komputer anda.

34

Menjaga Privasi
Kiat-kiat untuk ‘membentengi’
komputer dan berkas anda agar

tidak mudah disalahmanfaatkan oleh
orang lain.

32

Kasus Proteksi Folder
Contoh praktik perlindungan
folder dengan Folder Guard.

36

Modifikasi Registry
Proteksi folder juga dapat
dilakukan lewat registry.

38

Eggdrop untuk
Proteksi
Eggdrop adalah bot yang da-

pat digunakan untuk melindungi chan-
nel anda dari intrusi pihak lain. Contoh
disertai sumber akun shell.

16

Membuat Skrip mIRC
Cara membuat sendiri skrip untuk
mIRC, dimulai dengan beberapa

fungsi dasar yang dapat dibuat melalui
menu Tools pada program mIRC itu sendiri.

12

Daftar Isi

NeoSoft

RealProfil

NeoTek Juli 2002

PsyBNC
Setelah m engenal EggDrop sebagai
satpam chat room anda, kini kenali
bouncher dengan kemampuan yang
lebih canggih lagi.

Terminal Diskless
Berdayakan komputer-komputer tua
anda agar secanggih kemampuan
server-nya.

Mengganti Logo Windows
Hanya dengan bermodal text editor,
anda dapat mengganti logo Win-
dows pada sistem operasi Windows.

GIMP for Win0

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
David Sugianto
Stanley

Webmaster
Supriyanto

Pemasaran
Hedhi Sabaruddin
Tuti Sundari

Iklan dan Promosi
Stanley
Elvy Risma Nainggolan

Keuangan
Aswan Bakri

3

6

4

5

Software grafik setingkat
Photoshop disediakan
gratis bagi para pengguna
Windows.

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
Office Suites
Open USS
Chat Script/Bot

Daftar Isi CD NeoTek
Grafik, Animasi, dan Games

NeoRagam

Inbox
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Tentang Proteksi
& Pengaturan Chat

Tentang Proteksi
& Pengaturan Chat
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NeoRagam

AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
Keistimewaan CD NeoTek bulan ini adalah OpenUSS suatu software
administrasi pendidikan kelas dunia dan Office Suites, yang mencakup
Open Office selain juga penjaga privasi serta grafik, animasi, dan games.

CCDD  NNeeooTTeekk
JJuunnii  22000022

opik pada CD
NeoTek bulan ini
cukup beragam

sehingga sulit menentukan
mana produk unggulan
yang akan ditampilkan.

Dimulai dengan Office
Suites yang terdiri dari
banyak alternatif terhadap
Microsoft Office, mulai
yang tampak sederhana
seperti Easy Office
sampai yang merupakan
saingan tangguh seperti
Open Office, Ability
Office, maupun 602Suite
2001.

Selanjutnya, sehubungan
dengan bahasan mIRC yang
cukup ekstensif, disertakan
pula mIRC., IRC script,
EggDrop robot, Putty, serta
berbagai FTP client.
Menyertai tutorial ASP
dan JavaScript kali ini,
disajikan pula scripting
tools, yaitu editor untuk
ASP maupun JavaScript
serta Xitami, server kecil
untuk menguji skrip yang
telah anda buat.

Untuk mengatasi virus
disertakan pula anti virus
CIH, Klez, MyParty serta
trial version dari Norton
Anti Virus 2002, McAfee,
serta PC Cillin.

uOpen Office
Installer OpenOffice meng-
ingatkan kita pada StarOffice
yang juga tersedia baik pada
Windows maupun Linux.
Seperti juga Star Office, Open
Office kompatibel dengan
MS Office.

uAbility Office
Office Suite alternatif ter-
hadap MS Office yang ber-
jalan pada Windows, terdiri
dari write, database, spread-
sheet, dan photopaint. Full
version.

u602Suite 2001
Selain menyediakan PDF
Writer dalam 602Pro Print
dan network tool dalam
602Pro LAN Suite, 602
software juga menyediakan
office suite dengan tampilan
dan fungsionalitas tak kalah
dari MS Office.

uEasy Office
Alternatif lain terhadap MS
Office yang lebih sederhana,
terdiri dari versi penuh
(Office Suite) maupun versi
mini (Tiny Word).

TT

Chat Script/Bot
umIRC
Software chat yang
paling populer saat ini.
Disediakan dalam
beberapa versi.
uMr P Script
Belajar menggunakan
skrip siap pakai untuk
membuat skrip sendiri.

uEggDrop Bot
Jaga channel anda dari
para pengganggu dengan
bot EggDrop yang dapat
anda instal lewat linux
box secara remote dari
mesin Windows anda.
uPutty
Telnet dan SSH client
yang dapat anda gunakan
untuk menghubungi
linux box dari mesin
Windows anda.

OOFFFFIICCE SE SUUIITTEESS

khirnya suatu software
administrasi pendidikan

kelas dunia tersedia juga dari
dunia open source.Alternatif
terhadap software komersial
seperti Blackboard ataupun
WebCT yang dirasakan tidak
terjangkau oleh institusi-
institusi kita. OpenUSS
menggunakan konsep
Application Service Provider
dengan lisensi GNU Public
License.

uJava Virtual Machine
Semua komponen OpenUSS
menggunakan JDSK 1.2.2
dari Sun Microsystem.Anda
harus menginstal ini dulu
pada platform anda.

uData Layer
Menggunakan Hypersonix
SQL yang pada versi ini
sudah disertakan.

uBusiness Object Layer
Untuk menjalankan Business
Object digunakan JOnAs EJB

server. Selama versi final
Enhydra belum dikeluarkan,
kita harus menggunakan
JOnAs secara terpisah.

uPresentation Layer
Layer ini menggunakan
Enhydra yang harus diinstal
tersendiri.

OOPPEEN UN UNNIIVVEERRSSIITTY SY SUUPPPOPORRT ST SYYSSTTEEMM
http://openuss.sourceforge.net/openuss/developer/repositories/dowload/download.html

AA
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daftar isi cd neotekdaftar isi cd neotek
SCRIPTING
ASP Edit aspedit
EditPlus 2.1 epp211_en
JavaScript Editor 2.5 jse2em
JavaScript Menu Master jmmaster
JS Editor 2.0 jsedit160
Kimiko HTML Editor kimiko34
Platypus Editor pjedit
Script Builder 2.0 scrptbld

OFFICE SUITES
602Suite 2001 602Suite2001
Ability Office 2001 setup
EasyOffice (Office Suite) easyoffice
EasyOffice (Tiny) tinyeasyword
Open Office for Linux install641c_linux_intel.tar.gz
Open Office for Windows install641c_win32intel

OPEN UNIVERSITY SUPPORT SYSTEM
OpenUSS 1.2 Final openuss-dev-1-2-final
Business Objects Layer jonas-2-4-4
Presentation Layer enhydra3.1
JDK 1.2.2.011 Windows jdk-1_2_2_011-win
JDK 1.2.2.011 Linux jdk-1_2_2_011-linux-i386

mIRC SCRIPT DAN BOT
mIRC 5.91 mirc591t
mIRC 6.0 mirc60
mIRC 6.01 mirc601
mr P Script mrpscript
EggDrop eggdrop1.6.10.tar.gz
Putty putty

FTP CLIENT
Absolute FTP aftp20b3
BlueZone FTP evbzftp
CuteFTP cuteFTP
eFTP 3.2 eftp32
ExpressFTP 2 expressFTP2
EZFTP EZInstaller
FileZilla FileZilla1_8_1setup
Flash FXP FlashFXP
FTPDup ftpdup
FTP Edit 3.0 FTPEdit30Setup
FTP Manager 2.06 FTPManager206_bin
FTP Scheduler ftpsched
FTP Surfer 1.07 ftpsurfer107
FTP Explorer ftpx
Leech FTP lftp13
Octopus octopus
Remote Pad remotepad
Sendto FTP sftp22st
SFTP SFTPSetup
Unlimited FTP unlimitedftp
Vulcan Uploader vulcan-uploader-3.00
WS_FTP f_x86t32
XI FTP xiftp0.15

MENJAGA PRIVASI KOMPUTER
3eee Triple Encryption ssetup
Ad Aware 5.62 AdAware5_62
Buckshot buckshot
Camouflage camou111
ET et
Folder Guard fgstd
Hide Folders hf
KPK File kpkfil62
Lock My PC LockmyPC
Password Protection System setuppl
Program Lock ProgLock
PW Cache pwche10
Text Encrypter 5 TextEncrypter5
WinGuard Basic wgbasic
WinSecure-IT winsecure
XOSL xosl115
Zero PopUp 1.38 ZeroPopUp1_38

ANTI VIRUS
Anti Klez AntiKlez
Anti MyParty AntiMyparty
F-CIH f-cih
Fix CIH fix-cih
McAfee Virus Scan 6.02 McAfeeVscan6_0_2
McAfee Virus Upgrade McAfeeVSUpgrade
Norton Anti Virus 2002 setup
Panda Titanium 2 PandaTitanium2
PC Cillin 2000 pcc2k
PC Cillin 2000 for NT pccnt2k
Remove CIH RemoveCIH2
VCatch vcsetup

GRAFIK, ANIMASI, DAN GAME
3D Flash Animator 3.0 3DFlashAnimator3Setup
Abracadabra abra1
ACDSee 4.01 acdsee
Blender 2.23 blender-creator-2.23-windows
Blitz 2D setup
Coffee View 2.5 CoffeeView25
GIMP for Win gimp-1.2.3-20020310.setup
Irfan View IrfanView3_61
Poly View Polyview3_65

AUDIO-VIDEO PLAYER
DivX 4.12 Bundle DivX412Bundle
Media Player 7.1 MediaPlayer7_1
Real Player 8 RP8_setup
WinAmp 2.78 winamp2_78
WinAmp Skin Pack wa3skinpack2
WWWinAmp wwwinamp25d

PDF READER DAN PRINTER
602Pro Print printpack
Acrobat Reader 5.05 rp505enu
Sowedoo PDF SowedooEasyPDFConverter-Ev.

NETWORK TOOLS
602Pro LAN Suite ls2002
Active Ports 1.0 aports
LAN Led lanled
Sentinel Full SentinelFull
Xitami bw3224b9
Zone Alarm 2.65 ZoneAlarm2_65

SYSTEM TOOLS
Startest 3.5 startest3_5
System Guard SysGuard
System Safe Setup System Safe Setup
Sentinel Full SentinelFull

PROGRAM UMUM BERSELANCAR
DivX 4.12 Bundle DivX412Bundle
DirectX 8.1 DirectX8_1
MSI Installer InstMsiA
ShockWave Full Shockwave_Installer_Full
WinZip 8.1 winzip8_1

GGrraaffiikk,,  AAnniimmaassii,,  ddaann  GGaammeessGGrraaffiikk,,  AAnniimmaassii,,  ddaann  GGaammeess
u3D Flash Animator
Selain SWiSH, cara mudah
membuat animasi Flash ada-
lah dengan 3D Flash Anima-
tor yang full version-nya
disediakan oleh NeoTek.

uPlaystation Emulator
Jalankan playstation pada
komputer anda dengan VGS
(Virtual Game Station) yang
versi crack-nya sudah ber-
tebaran di Internet. Mau
mencoba?

uBlitz 2D
Ingin merasakan bagaimana
merancang game sendiri?
Gunakan Blitz 2D dengan
sedikit pemahaman pro-
gramming.

uGIMP dan Blender
Dua software grafis setara
Photoshop dan 3D Studio
Max yang sebelumnya
hanya ada di Linux. Kini ada
pula di PC. Canggih namun
gratis!
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Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTeker menjawab NeoTekerNeoTeker menjawab NeoTeker

Membentengi ID
T: Posted April 2
Ada yang tahu cara mem-
bentengi id/email kita agar
tak bisa disubscribekan di
milis yahoogroups?Pakai
software ato setting doang
di yahoogroups ?

Bambang S. Nugroho
bsn@bonbon.net

J: Posted April 3
Anda bisa mengedit setting
di http://groups.yahoo.com
/myprefs. Akan terlihat
nanti kayak gini

Email addresses Status Bounce
history Allow Direct Adds
Allow Invitations Options
green@c... Normal Bounce
history No Yes Options

Klik di option dan pilih tidak
pada Allow Direct Adds.

Jadi moderator tidak
seenaknya mengadd anda
jadi member milist dia =)

Redi Tya
green@cbn.net.id

J: Posted April 4
Aku sudah coba seperti sa-
ran anda, tetapi kok tetap sa-
ja ada orang yang masih bisa
meng-add email saya untuk
milist mereka?

Bambang S.Nugroho
bsn@bonbon.net

J: Posted April 5
Apakah situ telah mengubah
yes pada direct add jadi no?
Dan saya lihat anda pake
dua email.. 1 id yahoo satu
di ecco.com.

Berarti anda harus ubah dua
dua nya.. jadi no.

Redi Tya
green@cbn.net.id

Tentang SoftIce 
T: Posted April 3
Saya sudah coba softice u/
mencari serial number Win-
zip 8, tapi waktu diketik bpx
getdlgitemtexta kok pesan
selanjutnya invalid symbol
sih? Dan pada saat saya coba
masukan serial number dan
klik OK, softicenya kok gak
otomatis nge-break sih?
Gimana dong? Apa perintah
breakpointnya salah atau
bagaimana ?

Yedi Setiadi
yedi1419@yahoo.com

J: Posted April 4
Bukan perintah nya yang
salah tapi kamu udah setting
belum winice.dat nya hilang-
kan tanda ; didepan exp-nya
kemudian restart pc nya.
silakan dicoba gampang kok.

Buat rekan yang lain gimana
nich cara bikin patch buat
gak gak input srial number!

dns1.sendai.alsi.co.jp 8080
udah ngga bisa dipakai lagi,
mungkin udah di ban kali
yee.

Jason
jason1id@yahoo.com

J: Posted April 4
Friend... coba diikuti lagi
panduannya satu persatu,
mungkin ada yang terlewat,
sebab saya sudah praktikkan
sendiri dan berhasil.

Bagus Susatyo
bgs12760@yahoo.com

ISP Wireless LAN
T: Posted April 4
Saya termasuk yang baru
ikutan sekalipun sudah ba-
ca neotek sejak no 1. Saya
ingin info ISP yang mem-
beri layanan WLAN untuk
perorangan.

Bila dirasakan kurang etis
menyebutkan nama ISP itu
di milis ini, mohon info
dapat diberikan langsung
kepada alamat email saya
(japri).

Wibisana_Lucas
wibisana_lucas@yahoo.com

J: Posted April 4

ISP wireless pada mangkal-
nya kebanyakan di
indowli@yahoogroups.com
Kontak-nya antara lain
andi@asia.net.id (jakarta)
sumaryo@netadsl.net
(jakarta & jogya)
aulia@jalawave.net
(bandung)
louis@angin.com (surabaya)
adi@internux.co.id
(makassar)
irwin@internux.co.id
(makassar)

Cuma sekarang rata-rata
mereka males buat ngecer ke
perumahan soalnya cape
buat urusin eceran kecil-kecil
mereka lebih suka buat jual
glondongan besar yang Rp.
4-5 juta / bulan .....+ minta
anda yang mengecerkan
ke tetangga-tetangga lagi.

Tambahan
michael@batutulis.com
(bogor)

Beliau lagi ujicoba wavebolt
akses-nya kaya modem
telepon pakai USB.

Onno W. Purbo
onno@indo.net.id

Bikin Linux Club,Yuk!
T: Posted April 13
Gimana kalau rekan-rekan
neoteker membuat Linux
Club di wilayah tempat
tinggalnya masing-masing
(Kelurahan/Kecamatan).
Sehingga neoteker yang
tidak punya akses langsung

ke Internet dapat belajar
Linux dari rekan neoteker
lainnya. Kalau neoteker
yang punya akses langsung
ke Internet kalau ada
masalah dengan Linux
tinggal sambangi situs
distronya/bengkel linux
[Misal: www.mandrake-
user.org]. Kalau ada neote-
ker yang bisa MySQL bisa
ajarin neoteker lainnya
yang tidak mampu utk
kursus MySQL.

Untuk neoteker yang
tinggal di Kompleks
Bintaro Jaya dan Pondok
Aren, gimana kalau kita
buat Linux Club (Tolong
tanggapannya langsung ke
e-mail saya)?

Garuda Emas
adrian99@naver.co.id

J: Posted April 14
Anggota KPLI bukannya
pakar2 linux semua? Setahu
saya linuxer yg masih icip2
linux sedikit (kayak saya)
rada minder dgn organisasi
KPLI.Waktu saya mau daf-
tar di counter linux indone-
sia, ada pilihan: berapa lama
anda menggunakan linux,
dan pilihan minimum 2 ta-
hun ...hikss ...saya kenalnya
baru bulan lalu, gak jadi
daftar dehhh((padahal udah
ada label pemula).

Trus kalau saya lihat artikel
di majalah macam infoli-
nux, bahasannya kebanyak-
an terlalu cepat utk diikuti
newbie.

Paulus Tangke Allo
bekasyahu@telkom.net

J: Posted April 14
Kesimpulannya perlu juga
ya club linuxnewbie atau
neolinux :) ....

Onno W. Purbo
onno@indo.net.id
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3 WARNA TULISAN DAN LATAR
Tekan tombol Enter dan boom tulisan
anda akan ber warna. Selanjutnya un-
tuk membuat warna tulisan dan latar
belakangnya, lakukan mirip Langkah 1
& 2, hanya setelah nomor indeks per-
tama, tambahkan indeks nomer kedua
dengan pemisah tanda koma (,).

hatting saat ini merupakan salah
satu fasilitas yang paling digemari
para pengguna internet, karena

dengan menggunakan sarana ini kita bisa
‘ngobrol’ dengan siapa saja di seluruh
belahan dunia ini. Melalui tulisan ini  dapat
mempelajari salah satu fungsi dasar yang ada
di mIRC—salah satu program chat yang
populer. Pada halaman-halaman selanjutnya
akan menjumpai lanjutan penggunaan
program mIRC, sampai pada penggunaan
script pada mIRC yang merupakan tools dari
mIRC itu sendiri. Pertama mari kita belajar
cara membuat tulisan warna pada mIRC
standar sehingga tulisan atau teks yang anda
ketikkan menjadi meriah dengan warna-
warni pilihan anda.

TTEEKS BKS BEERWRWARARNANA
MMEEMMBBUUAAT CT CHAHAT RT ROOOOMM
#N#NEEOOTTEEKKEER LER LEBBIIH HH HIIDDUUPP

Jika ingin tampil sedikit beda dengan teman berbincang
anda di ruang ngobrol alias chat lewat mIRC, anda dapat
memoles teks obrolan anda dengan warna-warni. Eddie
Vedder memberitahukan caranya yang sederhana itu.

C

MEMBUKA OBROLAN
Lalu tuliskan kata seperti biasa
(Gambar 4a), hasilnya seperti pada
Gambar 4b. Yang perlu di ingat ada-
lah angka  sebelum koma menun-
jukkan warna font yang dipilih, se-
dangkan angka setelah koma
adalah tanda latar belakang .

WARNA PADA TIAP KATA
Untuk menuliskan setiap kata de-
ngan warna yang berbeda-beda
caranya juga mudah. Misalkan
kita tuliskan ‘teks warna warni’
dengan warna merah, hijau, dan
kuning, maka indeks yang dipilih
adalah 4, 2, dan 8.

MIRC COLOR INDEX
Letakkan kursor pada pada
window room waktu kita pv
(private chat) dan tekan tombol
Ctrl+K (tekan bersama-sama),
maka akan muncul kotak mIRC
Color Index 

SITUS DALNET
Untuk penggunaan warna tanpa latar
belakang, cukup pilih warna yang akan
digunakan dengan menulis nomor in-
deksnya pada layar yang sedang aktif
(Gambar 2a) dilanjutkan dengan me-
nulis kata atau kalimat yang akan
ditulis (Gambar 2b) .

1

4 5

2

Membuat chat room menjadi penuh warna...

CHAT ROOM PUN PENUH
WARNA
Dan inilah hasil dari ‘jerih payah’
anda. Teks obrolan menjadi
berwarna-warni dan chat room
menjadi penuh warna. Nggak
ngebosenin, gitu!

6
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IRC adalah salah satu program
IRC (Internet Relay Chat) yang
ditulis oleh Khaled Mardam-

Bey. Sebagai program shareware, mIRC
dapat di-download dari www.mirc.com.
Sebagai program chat, mIRC sebenarnya
dilengkapi dengan berbagai fasilitas dan
tool yang amat berguna ketika anda chat,
di antaranya membuat teks menjadi
warna-warni seperti yang diuraikan pada
halaman 7 atau proteksi agar anda tidak
di-flood lawan bicara anda ketika chat.
Semua ini dapat anda manfaatkan atau
aktifkan lewat fitur-fitur yang
disediakan.

Jika ketika menginstal anda belum men-
set mIRC anda sesuai dengan keinginan
anda, silakan ikuti uraian di bawah ini.

M

MASIH OPTIONS PADA IRC
Pilih ‘Rejoin channels on connect ‘ agar
jika terkena dc pada saat chat dan con-
nect kembali ke server, anda otomatis
masuk ke room terakhir tanpa harus
men-join satu persatu! Bila ingin lang-
sung masuk room apabila diundang
seseorang atau bot, pilih ‘Auto join
channel on invite.’

4

10 11

5 6

12

PILIHAN HIGHLIGHTS
Sekarang pilih ‘Highlights pada menu
‘IRC.’ Menu ini dapat memberitahu anda
bila ada yang memanggil nama atau ka-
ta yang anda set sebelumnya. Caranya
dengan memilih ‘Enable highlighting’ lalu
pada kotak ‘Highlight list’ pilih ‘Add.’

MENGISI ADD HIGHLIGHT
Pada Kotak ‘mIRC Add Highlight’ tulis
kata yang akan anda tandai bila di
ruang chat ada yang menuliskannya,
pilih juga warna yang anda inginkan
untuk membedakan dengan yang
lainnya. Klik tombol ‘OK’ jika telah
selesai. Ulangi prosedur yang sama
bila ada kata yang akan ditambahkan.

DCC UNTUK BERKIRIM FILE
Jika suka bertukar file saat chat, anda
harus mengaktifkan fasilitas DCC.
Pada menu ‘mIRC Options,’ klik
menu ‘DCC.’ Di sana anda dapat
menset fasilitas dcc apakah dimatikan
sehingga anda tidak dapat bertukar
file saat chat atau dihidupkan.

MENYARING FILE
Anda juga bisa memilih file apa yang
bisa dikirim melalui DCC dan file apa
yang tidak diterima. Untuk itu, anda
dapat men-setnya. Pada contoh DCC
akan meng-ignore file yang dikirim
melalui mirc kecuali file yang ber
ekstensi pada daftar.

OPTIONS DISPLAY
Pada pilihan ‘Display’ pada menu
‘Option,’ anda dapat memilih apa yang
akan tampil pada mIRC anda pada
saat connect ke server. Sebagai contoh,
pilih ‘Display’ dan masuk ke sub menu
‘Tray.’

Manfaatkan fasilitas mIRC untuk kenyamanan anda mengobrol.

MMEEN-N-SSEET MT MIIRRCC
UUNNTTUUK KK KEENNYYAMANAN CAMANAN CHAHATT

Sebagai program chat, mIRC dilengkapi dengan berbagai fitur yang
berguna saat anda chat. Eddie Vedder menguraikan cara men-set
beberapa fasilitas pada mIRC sehingga bisa lebih sesuai dengan
keinginan dan kebutuhan anda.
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OPTIONS LOGGING PADA IRC
Sekarang masuk ke menu ‘Logging.’ Di
sini anda bisa memilih apakah akan me-
log setiap pembicaraan yang ada di
room, atau pada pv-an atau bahkan
keduanya. Pada ‘Automatically log’ ada
pilihan mau channelnya saja yang di-log,
atau chat saja atau semuanya.

MELIHAT HASIL LOG
Untuk melihat hasil log, anda cukup
memilih menu ‘mIRC View Logs.’ Di sini
akan terlihat daftar log yang ada. De-
ngan menggunakan fasilitas log ini,
anda dapat membaca hasil pembicara-
an anda di chat atau pembicaraan
orang di room kapan saja.

PROTEKSI TERHADAP FLOOD
Pada menu ‘Flood’ di ‘IRC,’ anda
mengaktifkan proteksinya untuk
menghindari orang yang mem-flood
(membanjiri) anda dengan pesan atau
teks yang tidak anda inginkan.

1 2 3
OPTIONS PADA MENU IRC
Sekarang pilih menu ‘IRC’ dan klik dua
kali pilihan menu IRC. Terdapat berba-
gai pilihan yang dapat anda setel sesuai
keinginan anda. Tandai pilihan ‘Rejoin
channel when kicked’ sehingga bila di-
kick operator room, secara otomatis
anda akan masuk kembali ke room itu.

13 14 15
MEMUNCULKAN IKON MIRC
Pilih ‘Always show mirc icon intray’
apabila anda menginginkan ikon
mIRC muncul pada Sys Tray windows.

OPTIONS GENERAL
Anda masih dapat memanfaatkan
options atau pilihan lain pada mIRC ini.
Option ‘General,’ misalnya,
mempunyai dua sub menu ‘Servers’
dan ‘Lock.’

MENCEKAL PRIVATE CHAT
Jika tidak suka ‘mojok berdua,’ anda
dapat menonaktifkan (disable) private
chat, dengan menandainya pada
pilihan ‘Disable.’ Jika anda ingin mIRC
selalu menanyakan password sebe-
lum chat untuk mencegah orang lain
menggunakan mIRC di komputer
anda, aktifkan fitur ini.

OPTIONS PADA MIRC
Buka menu ‘File’ dan pilih ‘Option.’ Akan
muncul kotak dialog ‘mIRC Option.’ Pilih
menu ‘Connect’ dengan mengklik
tombol (+) di pojok kiri, maka akan
terlihat beberapa setting.

OPTIONS PADA MENU CONNECT
Pada menu ‘Options’ dari ‘Connect’
ada beberapa pilihan, seperti bila anda
ingin langsung terhubung server—
tandai pilihan ‘Connect on startup’—
atau mengatur berapa waktu yang
dibutuhkan untuk meng-connect
server.
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krip (script) pada mIRC sebe-
narnya hanya program tambah-
an. Skrip banyak macamnya, di

antaranya skrip perang (war), untuk pro-
teksi, bahkan juga untuk permainan ma-
cam scramble. Skrip dapat di-download
gratis di banyak situs, tetapi berhati-hati-
lah karena bukan tidak mungkin skrip yang
anda download mengandung backdoor
atau virus yang dipasang pembuat skrip.
Pada kesempatan ini kita membahas satu
skrip buatan putra Indonesia. Skrip ini
relatif mudah digunakan dan berbahasa
Indonesia. Dalam skrip ini terdapat  bera-
gam fungsi, seperti bot yang banyak
fungsinya, untuk pertahanan juga dapat
dibilang bagus. Script ini di namakan
oleh pembuatnya mr P script.

S

PERINTAH DASAR
Jika ingin mengetahui perintah dasar
pada mr P tersebut, anda bisa menekan
tombol F1 pada window status. Di sana
akan terlihat daftar perintah (command)
yang bisa digunakan pada mr P. 

4

10 11

5 6

12

MENU POP-UP
Setelah tersambung (connect) ke server
dan masuk ke salah satu room, anda
dapat menggunakan menu mr P ini
dengan mengklik kanan mouse sehingga
keluar menu pop-up seperti pada
gambar di atas.

SILAKAN COBA
Pada menu pop-up banyak fungsi
yang dapat anda gunakan. anda dapat
mentesnya satu per satu. Tetapi ingat,
anda harus hati-hati karena kalau
anda mentes yang agak ‘nakal,’ bisa-
bisa anda di-kick oleh op room.

INVITER BOT
Sekarang kita coba buka menu bot
untuk Inviter. Bot ini berguna untuk
mengundang (invite) orang agar mau
masuk ke room anda (biasanya di
gunakan untuk room baru).

MEN-SET INVITER BOT
Setelah bot diaktifkan, anda dapat
men-set menu bot tersebut seperti jika
anda akan mengundang orang yang
baru bergabung (join) untuk masuk
ke room tertentu, menset kata-kata
untuk mengundangnya. 

UNDANGAN BOT
Apabila anda sudah men-set tulisan
undangannya dan sebagainya, tiba
saatnya memasukkan bot tersebut ke
room yang ramai dikunjungi orang.
Setiap orang yang baru join ke room
yang ada bot anda akan diundang
oleh bot untuk datang ke room anda.

Dengan skrip, chat anda dengan mIRC bertambah ‘seru.’

BBEERRMAIMAIN DN DEENNGGANAN
SSKKRRIIP MP MIIRRCC
Walaupun hanya sebagai program tambahan, skrip sebenarnya
banyak faedahnya untuk para pengguna mIRC. Eddie Vedder
mengajak anda menyimak salah satu skrip buatan putra Indonesia
yang dapat anda download gratis dari Internet.
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YANG INI BOT
Sekarang mari kita coba bot yang
terdapat pada mrp scrpit. Untuk itu yang
harus dilakukan adalah membuka menu
mr P script di atas dan arahkan mouse
pada menu ‘Bot.’ setelah itu pilih bot
yang akan diaktifkan 

BOT AUTO CHATTING
Untuk pertama kali kita aktifkan bot
‘Auto chatting.’ Setelah di-load dan ter-
sambung ke server, anda dapat melihat
menu bot di menu pop-up. Di sana
anda bisa men-set apa saja yang akan
dijadikan sebagai bot: hanya di room
saja, di-peve-kan saja atau bahkan
menjadikannya sebagai 100% bot 

BOT PUN NIMBRUNG
Maka bot akan ikut berbicara apabila
ada kata yang di ucapkan di room
atau bila ada yang mem-peve bot itu.

1 2 3
TAMPILAN AWAL SKRIP
Setelah anda men-download-nya ikuti
petunjuknya (tentunya bahasa Indo-
nesia). Setelah selesai, buka program
mrp-nya yang terletak di direktori yang
anda pilih. Tampilan awal akan terlihat
seperti gambar di atas.

13 14 15
GAME BOT
Sekarang kita coba aktifkan bot untuk
game. Bot untuk bermain scramble
banyak disukai untuk selingan kita
chat.

BERMAIN SCRAMBLE
Setelah bot jalan dan dimasukkan ke
room, anda bisa mengaktifkan bot
tersebut untuk memulai permainan.

JAWAB PERTANYAANNYA
Bot pun akan memulai permainan.
Yang ada di room diminta menjawab
pertanyaan yang diajukan oleh bot.
Bot juga menyediakan menu seperti
melihat nilai (score).

SITUS SKRIP ITU
Untuk men-download-nya, masuk ke
alamat www.geocities.com/mrp_script .
Setelah itu klik menu ‘Download.’

MEN-DOWNLOAD SKRIP
Download mr P script menurut selera
anda. Anda bisa men-download-nya
satu per satu atau sekaligus. Di sana
juga ada kelengkapannya seperti skrip
untuk bermain scramble dan
sebagainya
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Skrip mISkrip mI RRCC
Skrip untuk mIRC selain dapat diperoleh lewat Internet juga dapat anda buat sendiri sehingga sesuai dengan

kebutuhan anda. Putut Indrayana menguraikan cara membuat sendiri skrip mIRC.

Membuat SendiriMembuat Sendiri

ILA SUDAH LAMA MENGENAL
MIRC, ada kemungkinan anda
ingin melakukan sesuatu

yang lain, seperti membuat skrip
mIRC sendiri. Setelah memperkenal-

kan skrip yang dapat anda download
dari situs di Internet (baca halaman
10-11), kali ini kami menyajikan cara
membuat skrip sederhana. Untuk itu
pertama anda akan diperkenalkan

dengan fungsi-fungsi yang mendu-
kung kerja skrip. Fungsi-fungsi itu
dapat anda buat dengan menggunakan
menu ‘Tools’ pada program mIRC itu
sendiri.

B

1 2 3
HASIL MENU POP-UP
Kini jika anda mengklik kanan mouse
pada jendela ‘Status’ akan muncul
menu pop-up ‘server liberty dalnet.’
Lalu jika anda mengklik menu terse-
but, anda akan langsung tersambung
(connected) ke server liberty.dal.net.

POPUPS PADA MENU TOOLS
Klik menu ‘Tools’ lalu pilih ‘Popups.’
Anda juga dapat menggunakan
kombinasi tombol ‘Alt + P’ untuk
membuka menu ini.

MEMBUAT MENU POP-UP
Pada ‘mIRC Editor,’ di bagian ‘View’
klik tab ‘Status.’ Selanjutnya ketik
baris berikut:
.server liberty dalnet :/liberty.dal.net
Setelah selesai, klik tombol ‘OK.’

1 2 3
HASIL REMOTE
Jika anda mengklik kanan mouse pada
‘Status’ akan muncul menu ‘server liber-
ty dalnet’ untuk tersambung ke server
itu. Bagian Remote inilah yang akan
digunakan untuk menjalankan skrip
yang akan kita buat nanti. Namun untuk
mengaktifkan skrip, harus diketikkan
/remote on, sebaliknya /remote off.

REMOTE PADA MENU TOOLS
Anda juga dapat membuat pop-up
dari remote. Untuk itu klik menu
‘Tools’ lalu pilih ‘Remote.’ Anda juga
dapat menggunakan kombinasi
tombol ‘Alt + R’ untuk membuka
menu ini.

MEMBUAT REMOTE
Kembali terbuka jendela ‘mIRC
Editor’ yang langsung mengantarkan
anda ke area ‘Remote.’ Di bawah
tab ‘Remote’ ketik yang berikut:
menu status {
&server liberty.dalnet : /server liberty.dal.net

FUNGSI POP-UP

FUNGSI REMOTE
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1 2 3
HASIL ALIASES
Fungsi aliases adalah untuk memper-
singkat perintah yang panjang. pada
contoh ini, jika kini anda mengetikkan
/ji pada bagian bawah jendela ‘Sta-
tus,’ maka anda otomatis akan ter-
sambung ke channel #indonesiana,
#neoteker, dan #tangerang.

ALIASES PADA MENU TOOLS
Selanjutnya mari membuat fungsi
aliases. Untuk itu, klik menu ‘Tools’
lalu pilih ‘Aliases.’ Anda juga dapat
menggunakan kombinasi tombol ‘Alt
+ A’ untuk membuka menu ini.

MEMBUAT ALIASES
Terbuka jendela ‘mIRC Editor’ yang
langsung mengantarkan anda ke
area ‘Aliases.’ Di bawah tab ‘Aliases’
ketik yang berikut:
/ji /join #indonesiana | /join

#neoteker | /join #tangerang

FUNGSI ALIASES

FUNGSI ALIASES

Langkah selanjutnya adalah membuat
events. Jika events ini terpenuhi maka
skrip anda akan bekerja sesuai
kehendak anda. Perlu diingat bahwa
semua skrip ini ditulis di bagian
Remote dan bekerja hanya untuk
perintah-perintah di server dalnet.

EVENTS
Perintah umum: on *:events : command

Jika ketika pertama kali tersambung
anda ingin langsung join ke #neoteker
maka perintahnya menjadi:

On 1:connect: join #neoteker

Contoh events ini bisa berlaku juga
untuk on start, on disconnect, on join,
on part, on quit, dan lain-lain. Contoh
on start:

on 1:start {
.nick $$?=”masukkan nickname kamu”

.server paronia.dal.net
}

Maka ketika pertama kali dijalankan
mIRC secara otomatis akan meminta
input nickname anda, dan kemudian
akan ter-connect ke server
paronia.dal.net.

$$? adalah untuk menampilkan
request input.

SKRIP MIRC

Sekarang kita akan membuat script
sederhana:

SKRIP ANTI SPAM

Jika proteksi terhadap spam ini diak-
tifkan, semua query window yang
masuk ke kita dan mengandung kata:

join, #, /j, type /j, akan tertutup secara
otomatis sehingga kita tidak perlu kha-
watir dengan para inviter. Dan anda
tidak suka dengan orang lain yang
mengatakan sesuatu, anda tinggal
mengganti bagian

on 1:TEXT: <bagian yang diganti> :?:set
%nickad $nick | close -m $nick

dengan kata-kata yang kita suka.

.enable dan .disable adalah untuk
mengaktifkan skrip.

SKRIP ANTI UNBAN

Dengan skrip unban ini orang yang
sudah anda ban dari channel tidak
akan bisa dicabut lagi ban-nya, dan
akan terus di-ban selama anda masih
menjaga channel itu.

$nick menunjukan nick yang chat
$me adalah nick anda

halt adalah perintah untuk menghenti-
kan proses yang berlangsung pada skrip.

SKRIP KICK REVENGE

Skrip di atas adalah skrip  untuk mem-
balas kick orang yang meng-kick anda
dari channel. Dan skrip ini akan terus
meng-kick orang tersebut hingga 5
kali kick, dan setelah itu orang terse-
but akan kena ban secara otomatis. Te-
tapi untuk dapat meng-kick orang

Menu menubar {
&spam protection

.&on: .enable #spam | echo -a  0,3
spam protection  4,8 Enable  

.o&ff: .disable #spam | echo -a  0,3
spam protection  4,8 Disable  
}
;spam protection
#spam on
on 1:TEXT:*join*#*:?:set %nickad $nick
| close -m $nick 
on 1:TEXT:*/j*:?:set %nickad $nick |
close -m $nick 
on 1:TEXT:*type /j*:?:set %nickad $nick
| close -m $nick
#spam end

Menu chanel {
&never unban!! <think twice>

.&on: .enable #unban | echo -a  0,3
never unban  4,8 Enable  

.o&ff: .disable #unban | echo -a  0,3
never unban  4,8 Disable  
}
;never unban
#unban on
on *:UNBAN:#: {

if ($nick == $me) { halt }
else { mode # +b $banmask | halt }

}
#unban end
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tersebut kita harus punya akses op
atau tanda @ didepan nick kita.

MENJALANKAN PROGRAM 
DARI MIRC

Anda dapat menjalankan program di
Windows melalui mIRC dengan cara
mengetik /run <program.exe> dan
kita akan membuat skrip sederhana
untuk bisa menjalankan beberapa
program di mIRC.

MELAKUKAN LOADING 
SKRIP ADDON
Skrip addon adalah skrip  yang hanya

berupa file teks sederhana yang dapat
anda load untuk kebutuhan anda.
Cara melakukan loading skrip ini
adalah:

/load -rs  <path dan nama filenya>

Contoh, jika anda ingin me-load file
script1.mrc dari lokasi file c:\mirc
maka perintahnya: /load -rs
c:\mirc\script1.mrc.

penUSS adalah singkatan dari
Open University Support
System. Dan OpenUSS ada-

lah perangkat lunak administrasi
pendidikan yang merupakan hasil dari
Open Source Project sehingga tersedia
gratis bagi dunia pendidikan dan
mereka yang berkecimpung di
dalamnya, seperti mahasiswa, dosen,
pihak universitas, dan sebagainya.

Konsep OpenUSS
OpenUSS dibuat berdasarkan model
ASP (Application Service Provider)
yang berarti satu organisasi atau lebih
dapat ditangani sekaligus oleh
OpenUSS. Program ini memberikan
fleksibilitas kepada penggunanya
untuk memilih peralatan untuk
mengakses OpenUSS. Beberapa
contoh peralatan yang dapat
disebutkan di sini adalah PC, Personal
Digital Assistants dan telepon selular.

Menu chanel , nickname {
&kick revange 

.&on : .enable #kick | echo -a  0,3 kick revange 5 times  4,8 Enable  

.o&ff : .disable #kick | echo -a  0,3 kick revange 5 times  4,8 Disable  
}
;revange kick
#kick off
on !1:kick:#: {

if ($knick == $me) { set %kicker $nick | .auser 10 $nick | timer1 1000 10 join
$chan | halt }
}
on !1:op:#: {

if (%kicker ison $chan) { kick $chan %kicker  3,1 Kick with No ShadoW
12,8Prayana stille      0,4 Enable   | unset %kicker | timer1 off }
}
on +10:join:#: { kick $chan $nick  4 *  12,3 Bedebah!!! Diee $nick Diee!!!  | .ruser
10 $nick | .auser 20 $nick }
on +20:join:#: { kick $chan $nick  | .ruser 20 $nick | .auser 30 $nick }
on +30:join:#: { kick $chan $nick  4* Diee!!!!   | .ruser 30 $nick | .auser 40 $nick }    
on +40:join:#: { kick $chan $nick  4* Diee!!!!   | .ruser 40 $nick | .auser 50 $nick }    
on +50:join:#: { kick $chan $nick   4 * Diee!!!!   | mode $chan +b $address |
.ruser 50 $nick }                                                                                               
#kick end 

• Skrip Kick Revenge di samping kanan
ini adalah untuk meng-kick orang yang
pernah meng-kick anda dari chat room.

menu menubar,channel {
-
Run Programs
.Drive C:run c:
.Drive ?:run $$?="What Drive?" $+ :
.-
.ACD see:run acdsee.exe
.Explorer:run explorer.exe
.Yahoo Mail:run iexplore.exe

"http://mail.yahoo.com"
.-
.URL?:run iexplore.exe " $+

$$?="Enter URL Address" $+
"

Mengenal OpenUMengenal OpenUSSSS
O

Extension Components

Foundation Components

Komponen OpenUSS
OpenUSS didasarkan pada arsitektur berorientasi-komponen yang membagi
keseluruhan komponen menjadi dua bagian: Foundation Component dan
Extension Component. Foundation Component adalah komponen utama di
dalam OpenUSS dan merupakan representasi dari e-learning domain-
oriented components. Semua domain yang tidak terikat pada fungsi digo-
longkan ke dalam Extension Components. Pemisahan kedua komponen ini
memudahkan pengembangan fungsi-fungsi lain yang terpisah dari keselu-
ruhan sistem. (Program OpenUSS dapat diperoleh di CD Neotek bulan ini).
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O UNLOCK AND CONNECT THE INDONESIAN PEOPLE'S
KNOWLEDGE adalah misi utama dari IndonesiaDLN.
IndonesiaDLN adalah sebuah jaringan perpustakaan

digital pertama di Indonesia. Pada tanggal 6 Juni 2001 di
Bandung, jaringan ini diluncurkan dan diresmikan oleh para
penggagas dan pendirinya. Acara ini dilaksanakan bersama-
an dengan ulang tahun Perpustakaan Pusat ITB ke 80 yang
diisi dengan seminar internasional tentang pengelolaan ilmu
pengetahuan dan perpustakaan digital.

Jaringan perpustakaan digital yang dibangun ini adalah
jaringan yang sebenarnya, baik dalam arti fisik (jaringan
melalui internet) maupun secara kolaborasi. Setiap partner,
baik itu berupa institusi, warnet, atau personal, akan
memiliki server perpustakaan digital sendiri. Mereka
mengelola ilmu pengetahuan yang dimiliki ke dalam server
masing-masing dalam format digital, seperti file-file artikel,
kisah sukses, teknologi tepat guna, laporan penelitian, tugas
akhir, tesis, disertasi, publikasi, jurnal, foto-foto, rekaman
suara, rekaman video digital, dan lain sebagainya. Ilmu

pengetahuan tersebut diorganisasikan menggunakan sistem
kategori atau direktori menurut tema dan subjeknya. Hal ini
akan memudahkan anda untuk menelusuri kandungan
knowledgebase yang berisi ilmu pengetahuan tersebut.

Anda dapat mengakses perpustakaan online ini secara
gratis dengan hanya mengisi form pendaftaran, yang
diperlukan hanyalah alamat email yang valid. Selain itu
apabila anda sebagai individu, warung internet, atau
perusahaan ingin berbagi ilmu pengetehuan, anda dapat
membangun server digital library yang terhubung ke
IDLN dengan cara men-download software yang ada di
http://gdl.itb.ac.id.

Dengan bergabung dengan IDLN informasi tentang ilmu
pengetahuan tersebut menjadi lebih dekat dengan anda.
Dari komputer manapun, bahkan dari PC pribadi pun, anda
dapat mencari dan menelusuri ‘memory’ raksasa bangsa
Indonesia. Ilmu pengetahuan dari berbagai sumber dapat
disajikan dalam sebuah halaman web.

IndonesiaDIndonesiaDLNLN
PPerpustakaan Online Indonesiaerpustakaan Online Indonesia

IndonesiaDLN kepanjangan dari Indonesia Digital Library Network adalah sistem perpustakaan online
yang dikembangkan agar Anda dapat mengaksesnya tanpa harus berpergian ke lokasi tempat

perpustakaan itu berada.  Anda tinggal masuk ke http://idln.itb.ac.id 
dan anda akan langsung terhubung ke semua digital library yang sudah tergabung di dalamnya.

T

3 LOGIN
Jika aktivasi sukses akan muncul
status Success, coba account
anda dengan cara Login, isi
username, password, dan domain.
Klik Login GaneshaDL untuk
masuk. Jika di kiri atas tertulis
Welcome Nama Anda, maka
account anda bisa digunakan.

MENGISI REGISTRATION FORM
Masuk ke alamat
http://www.indonesiadln.org/regi
stration.php, kemudian isi seluruh
field yang ada. Setelah selesai klik
Submit Registration. Email anda
harus benar karena akan dijadikan
username dan URL aktivasi akan
dikirim ke email anda.

MENGAKTIFKAN MEMBER
Anda akan menerima email dari
GDL Server. Buka email tersebut
dan klik pada link aktivasi. Masuk
ke halaman aktivasi, username=
email anda, contoh:
bondan@waroengbedjo.com,
Validation number: 10 digit
angka. Klik Activate.

1 2

Mendaftar menjadi anggota dari IDLN pada http://www.indonesiadln.org/registration.php
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ggdrop bot pertama kali dibuat
sekitar 1993 untuk membantu
menghentikan perang di channel

#gayteen di efnet. Setelah itu Eggdrop
menjadi terkenal dan banyak digunakan
untuk proteksi channel.

Eggdrop bot ini memberikan perlindung-
an 24 jam 7 hari seminggu bagi channel.
Saya akan mencontohkan cara menginstal
Eggdrop dengan account di www.trace-
network.net. Perlu anda ketahui jarang
sekali shell account gratis memperboleh-
kan dijalankannya proses background ini.

Anda harus mempunyai akun shell yg
memperbolehkan menjalankan background
process. www.shellindo.com menyediakan
shell bayar dengan harga dalam rupiah.

E

MEN-DOWNLOAD EGGDROP
Ketik wget www.geteggdrop.com. Ini
akan men-download eggdrop
terbaru yaitu eggdrop1.6.10.tar.gz
ke shell anda

4

10 11

5 6

12

MENGEKSTRAK EGGDROP
Ketik tar -zxvf eggdrop1.6.10.tar.gz
untuk mengekstrak eggdrop-nya. File-
file akan terekstrak ke folder
eggdrop1.6.10

MEMBUKA DIREKTORI EGGDROP
Ketik cd eggdrop1.6.10 untuk
membuka direktori eggdrop1.6.10,
untuk kemudian melakukan proses
berikutnya di dalam folder ini.

INSTALASI EGGDROP
Ketik make install DEST=~/eggdrop
untuk menginstalasi program
EggDrop ini.

PROGRAM EGGDROP TERBENTUK
Program EggDrop telah terbentuk.
Ketik cd ~ dan masuk ke folder
eggdrop cd eggdrop (default
folder).

MENGEDIT EGGDROP
Di folder eggdrop terdapat 3 file:
eggdrop.complete.conf, eggdrop.
advanced.conf, eggdrop.simple.conf.
Salah satu file mesti anda edit agar
bot anda berjalan. Download salah
satu file ini menggunakan WS_FTP
dan edit dengan menggunakan
program Edit Plus.

Menyewa ‘body guard’ untuk melindungi channel anda

PPRROOTTEEKSKSI CI CHANHANNNEEL DL DEENNGGANAN
EEGGGGDDRROOP BP BOOTT
Anda memerlukan pelindung untuk mengamankan channel anda?
Eggdrop adalah program bot yang dapat anda gunakan untuk
tujuan itu. Redi Tya menguraikan cara mendapatkan, menginstal,
dan menjalankan Eggdrop di komputer anda.
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7 8 9
MENGKONFIGURASI EGGDROP
Ketik ./configure untuk mengkonfi-
gurasi eggdrop agar mengenali sis-
tem anda. Proses yang terlihat di
layar ini akan menghasilkan file
Makefile dari Makefile.in

MAKE CONFIG
Sebelum melakukan kompilasi,
ketikkan dulu make config untuk
menghasilkan file-file Makefile yang
diperlukan.

MAKE: KOMPILASI PROGRAM
Ketik make untuk mengkompilasi
program EggDrop menggunakan
GNU C Compiler (gcc).

1 2 3
LOGIN
Masukkan Login dan Password shell
anda

13 14 15
Anda harus mengedit dari nick bot,
Master, Channel, dll. Jika baru per-
tama kali menginstal eggdrop, saya
sarankan mengedit eggdrop.simple.
conf. Jangan lupa menghapus perin-
tah die di file ini atau bot anda tidak
akan jalan. Setelah selesai, upload
kembali eggdrop.simple.conf ke
folder eggdrop di shell anda.

Ketik ./eggdrop -m eggdrop.simple conf.
Bot anda akan muncul dalam irc server
pilihan anda. Anda harus me-message bot
agar mengingat anda sebagai admin. Ketik
“/Msg nick-bot hello” di irc. Set passnya
ketik "/Msg nick-bot pass inipasswordsaya."
Ketik "/Msg nick-bot auth inipasswordsaya"
untuk mengeset passnya dan menggenal-
kan diri anda sebagai master.

BOT PELINDUNG ANDA
Sekarang anda  telah  mempunyai
bot pelindung di irc. Untuk melihat
perintah bot ketik /ctcp nick-bot
chat . Masukkan user dan password
anda dan ketik .help (memakai titik
di depan)

DOWNLOAD TOOLS-NYA
Untuk lebih mudahnya download dan
gunakan program di bawah ini untuk:
a. Telnet: Putty (www.chiark.greenend.

org.uk/~sgtatham/putty/) 
b. Ftp: WS FTP (www.ipswitch.com atau

www.download.com)
c. Edit file: Edit Plus (www.editplus.com)

TELNET DENGAN PUTTY
Telnet ke shell anda dengan putty.
Masukkan shell.tracenetwork.net
di bagian hostname dan portnya
masukan 23 dan klik Open.
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Tipe Data
Tipe Data adalah nilai-nilai yang dapat digunakan. Ada
beberapa tipe data yang dikenal dalam Javascript yaitu:

Tipe Data Numerik
Yaitu tipe data yang berupa angka atau bilangan. Javascript
mengenal bilangan bulat  (Integer) maupun bilangan
desimal atau pecahan (Real).

Contoh:
Tipe Data String
Tipe data yang bukan berupa angka tetapi berupa kumpul-
an karakter. Tipe data string ditandai dengan diapit oleh
tanda petik, baik petik tunggal maupun petik ganda.

Perhatikan contoh berikut:
Kedua pendefinisian di atas adalah benar. Penggunaan ke-
dua jenis tanda petik secara bersamaan juga diperbolehkan
untuk membedakan tanda petik dalam string dengan tanda
petik pengapit string.

Perhatikan contoh berikut:
Kedua contoh di atas  juga benar. Namun kita tidak boleh
mencampuradukkan kedua tanda petik sehingga tidak lagi

saling berpasangan. Perhatikan contoh berikut:
Kedua contoh di atas salah karena tanda petik saling
bertindihan dan tidak lagi berpasangan.

Karakter Khusus
Dalam tipe data string dikenal beberapa karakter khusus
yang tidak bisa dituliskan dengan begitu saja. Contohnya
adalah tanda petik seperti di atas. Cara lain menuliskan
tanda petik dalam tipe data string adalah dengan tanda
backslash.

Perhatikan contoh berikut:
Selain tanda kutip ada beberapa lagi karakter khusus
lainnya yang jika dituliskan dalam string akan diawali
dengan tanda backslash.

Tipe Data & VTipe Data & Variabelariabel
Setelah memperkenalkan JavaScript pada nomor terdahulu, NeoTek melanjutkan tutorial JavaScript dengan

pengenalan tipe data dan variabel. 

“Saya berkata : ‘Saya belajar Javascript” ‘
‘Saya berkata : “Saya belajar Javascript’ “

2, -10, 4.5

“Saya berkat : \”Saya belajar Javascript\” “
‘Saya berkat : \’Saya belajar Javascript\’ ‘

Karakter Makna

\b Mundur ke arah kiri
\t Tab
\n Garis baru
\\ \
\; ;
\& &

“Saya belajar Javascript”
‘Saya belajar Javascript’

“Saya berkata : ‘Saya belajar Javascript’ “
‘Saya berkata : “Saya belajar Javascript” ‘

Mengenal JavaScriptMengenal JavaScript
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Tipe Data Boolean
Tipe data kondisional, hanya mempunyai dua nilai kemung-
kinan yaitu true atau false. Dalam hal ini 0 diartikan
sebagai false, sedangkan selain 0 diartikan sebagai true.

Tipe Data Null
Tipe data yang tidak memiliki nilai, atau kosong.

Variabel
Definisi

Variabel adalah tempat dari nilai tipe data akan disimpan.
Nilai variabel dapat berubah-ubah selama proses program
sesuai dengan keperluan.

Deklarasi
Suatu variabel JavaScript sebelum digunakan, ada baiknya
dideklarasikan terlebih dahulu. Deklarasi dapat dilakukan
dengan menggunakan statement vardi depan nama
variabel yang akan dideklarasikan.

Perhatikan contoh berikut :

Atau dapat juga jika sekalian diisikan nilai dari variabel
bersangkutan saat mendeklarasikan.

Perhatikan contoh berikut :

Catatan:
Spasi putih (white space) antara nama variabel dengan
operator sama dengan dan antara operator dengan nilai
variabel adalah opsional, dan digunakan hanya untuk
memudahkan kita dalam membaca skrip. Jika anda ingin
menghemat betul space yang dipakai maka spasi dapat
dihilangkan.

Contoh berikut sama dengan contoh di atas:

Penamaan
Nama variabel pada dasarnya bebas sesuai dengan yang
anda inginkan dan dapat dipilih yang sekiranya dapat me-
mudahkan pembuatan skrip, namun ada beberapa persya-
ratan yang harus dipenuhi oleh nama variabel yang dibuat,
yaitu:
a. Nama varaibel dapat terdiri dari huruf, angka dan tanda

garis bawah (underscore) atau kombinasi dari ketiganya,
dengan persyaratan karakter pertama dari nama variabel
harus merupakan huruf atau tanda garis bawah.

b. Nama variabel tidak boleh mengandung spasi.
c. Nama variabel tidak boleh merupakan statement dari

Javascript yang sudah ada.

Perhatikan contoh berikut untuk memperjelas syarat di atas:

Penting! JavaScript memiliki sifat case-sensitive, sehingga
perbedaan besar kecilnya huruf akan juga membedakan
nama variabel. Sebagai contoh nama variabel SAYA tidak
sama dengan variabel saya atau SaYa atau sAyA atau Saya
dan seterusnya.

Nilai
Memasukkan nilai ke dalam variabel yaitu dengan
menggunakan operator sama dengan (assignment
operator).

a. Variabel dengan nilai numerik
Perhatikan contoh berikut :

b. Variabel dengan nilai string
Perhatikan contoh berikut :

Catatan:
Suatu string dapat diputus penulisannya jika terlalu
panjang dan dipindahkan ke baris berikutnya dengan
menggunakan tanda backslash ( \ ).

Berikut adalah contohnya:

c. Variabel dengan nilai Boolean
Berikut adalah contoh memasukkan nilai boolean (true
atau false) ke dalam suatu variabel:

d. Variabel dengan nilai null
Perhatikan contoh berikut :

//contoh nama variabel yang benar
var namavariabel
var _namavariabel

//contoh nama variabel yang salah
var nama variabel //tidak boleh ada spasi
var 1variabel //tidak boleh diawali dengan angka
var var // tidak boleh menggunakan statemen javascript

<var nama_variabel1;
var nama_variabel2;

// atau boleh dengan digabung
var nama_variabel1, nama_variabel2, nama_variabel3;

var angka1 = 12
var angka2 = 4.5

var str1 = “Javascript”
var str2 = ‘Javascript’

Var nama_variabel1 = nilai variabel

// atau boleh tanpa menyebutkan statement var
nama_variabel1 = nilai variabel

Var nama_variabel1=nilai variabel

// atau boleh tanpa menyebutkan statement var
nama_variabel1=nilai variabel

var pilihan1 = true
var pilihan2 = false

var str1 = “Mempelajari javascript itu \
sangat menyenangkan”

// variabel di atas akan sama dengan variabel di bawah
ini:
var str2 = “Mempelajari javascript itu sangat
menyenangkan”
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Catatan:
Pemberian nilai null kepada suatu variabel adalah sama
dengan menghapus isi variabel , sehingga variabel menjadi
kosong.

Menampilkan Nilai
Setelah suatu variabel terisi nilai, maka untuk
menampilkan nilai variabel tersebut ke dalam dokumen
HTML digunakan statement document.write().

Perhatikan contoh berikut :

Perhatikan bahwa statement document.write() akan menu-
liskan semua yang diapit oleh tanda kurung sebagai isi dari
dokumen HTML, jadi bukan hanya untuk menuliskan teks
saja, akan tetapi bisa juga untuk menuliskan tag-tag HTML.

Untuk lebih jelasnya perhatikan contoh pada kolom berikut
yang merupakan modifikasi dari file di atas. Pada contoh
tersebut kita menggunakan Javascript untuk menuliskan
dokumen HTML secara utuh termasuk tag-tagnya juga.

Scope Variabel
Dilihat dari scope-nya variabel dapat dibedakan menjadi :

a. Variabel Global
Yaitu variabel yang dikenal secara global oleh semua
bagian script. Variabel global biasanya merupan variabel
yang terdeklarasi tidak di dalam fungsi.

b. Variabel Lokal 
Yaitu variabel yang hanya dikenal secara lokal pada
bagian dimana variabel tersebut dideklarasikan.
Biasanya merupakan variabel yang dideklarasikan di
dalam suatu fungsi. Kita akan mempelajari kembali
variabel lokal ini pada bagian yang membahas fungsi.

Catatan:
- Variabel global dapat diakses dari dalam maupun luar

fungsi manapun, sementara variabel lokal tidak dapat di
akses dari luar fungsi di mana variabel tersebut
dideklarasikan.

- Pada dua fungsi yang berbeda, diperbolehkan adanya
deklarasi variabel lokal dengan nama yang sama.

<!--  simpan dengan file js3.htm -->
<html>
<head>
<title>Menampilkan isi variabel</title>
</head>
<body>
<script language="javascript">
<!--
var var1,var2,var3
var1 = 1
var2 = "Javascript"
var3 = null
document.write("Isi dari variabel var1 adalah"+ var1

+"<br>")
document.write("Isi dari variabel var2 adalah"+ var2

+"<br>")
document.write("Isi dari variabel var3 adalah"+ var3

+"<br>")
//-->
</script>
</body>
</html>

<!--  simpan dengan file js4.htm -->
<html>
<head>
<title>Menampilkan isi variabel</title>
</head>
<body>
<script language="javascript">
<!--
var var1,var2,var3
var1 = 1
var2 = "Javascript"
var3 = null
document.write("<html>")
document.write("<head>")
document.write("<title>Menampilkan isi
variabel</title>")
document.write("</head>")
document.write("<body>")
document.write("Isi dari variabel var1 adalah"+ var1
+"<br>")
document.write("Isi dari variabel var2 adalah"+ var2
+"<br>")
document.write("Isi dari variabel var3 adalah"+ var3
+"<br>")
document.write("</body>")
document.write("</html>")
//-->

var satu = 1
satu = null

// atau langsung
var dua = null

NeoTek Vol II No 1 
NeoTek Vol II No 2
Dapatkan NeoTek Vol II, No 1 & 2, yang kini
ber-CD di toko-toko buku Gramedia atau
pesan langsung ke Redaksi
(redaksi@neotek.co.id).
CD Vol II No 1: Trojan (BO, Deep Throat, dsb.) •Glock Software
(Aanalyzer, Easy Mail dsb.) •Audio Video (Global DivX, Audio
Converter) • Web Graphic Tools (Web Graphics, Text2Web dsb.)

CD Vol II No 2: Scripting Tools for Windows (Active Perl, Active
Pyhton, dsb.) • Web Server (Personal Web Server, Xitami, dsb.) •
Windows Port Scanner (Superscan, AATools, dsb.) • Network
Security (Black ICE, Putty).

Relaunched
+ CD!

Harga Rp19.500,- per nomor



NeoTutor

Juni 2002 NeoTek 21

IKA ANDA SERING KALI menjela-
jahi Internet, khususnya ber-
sifat personal Web, sering kita

temukan adanya fasilitas buku tamu
yang berfungsi agar pengunjung dapat
meninggalkan pesan ataupun menan-
dakan bahwa seseorang pernah mengun-
jungi halaman Web tersebut. Banyak
situs portal yang menyediakan fasilitas
buku tamu gratis, namun sayangnya
mereka menambahkan banner yang
cukup mengganggu tampilan buku
tamu. Lewat uraian kali ini kita akan
membuat fasilitas buku tamu sendiri
yang sesuai dengan kebutuhan dan
keinginan kita. Dalam membuat buku
tamu ini, kita dihadapkan pada dua
pilihan media untuk menyimpan data,
yaitu berupa teks atau database. Kita
akan membahas masing-masing pilih-
an beserta contoh dan penjelasan sing-
katnya. Mari kita mulai membuatnya.

Teks Buku Tamu
Dalam membuat teks buku tamu, kita
memerlukan setidaknya 3 file yang
berperan sangat penting. File-file ter-
sebut antara lain:

File untuk Menyimpan Data
(bukutamu.txt)
Buatah sebuah file yang akan kita gu-
nakan untuk media penyimpan data
dengan nama file bukutamu.txt. Cara-
nya buka notepad atau text editor lain.
Anda tidak perlu mengisi apa-apa di
editor tersebut, cukup simpan dengan
nama bukutamu.txt. Jadi file ini
merupakan file kosong

A. File untuk Menampilkan
Form (form.asp)
Ketikkan kode berikut di teks edi-
tor kesayangan anda. Lalu sim-
panlah dengan nama ffoorrmm..aasspp

Jika file form.asp dibuka dengan
browser, hasilnya akan tampak
seperti gambar di sebelah kanan.

J

Membuat BukMembuat Buku Tu Tamuamu
Jika anda ingin mengumpulkan informasi profil pengunjung situs anda, buku tamu adalah bagian

penting dari upaya itu. Dengan menggunakan ASP, David Sugianto menguraikan cara
pembuatan buku tamu dengan contoh penyimpanan data berformat teks dan basis data.

<html><head>
<title>Buku Tamu</title>
</head>
<body>
<form method="POST"
action=thanks.asp>

<p align="center"><font
size="5"><b>Buku Tamu</b></font></p>
<hr>
<table border="0" width="62%">
<tr>

<td width="34%">Nama</td>
<td width="66%"><input type="text" name="txtnama"
size="37"></td>  </tr>  <tr>   <td width="34%">Email</td>
<td width="66%"><input type="text" name="txtemail"
size="37"></td>

</tr>
<tr>

<td width="34%">Komentar</td>
<td width="66%"><textarea rows="6" cols="31"
name="txtkomentar"></textarea>

</td>
</tr>

</table>
<p><input type="submit" value="Kirim"> <input type="reset"
value="Hapus"></p>

</form>
</body></html>

Aplikasi Sederhana ASAplikasi Sederhana ASPP
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B. File untuk Ucapan Terima
Kasih dan Memasukkan Data ke
Teks (thanks.asp)
Ketikkan kode berikut ini ke teks
editor kesayangan anda, kemudian
simpan dengan nama tthhaannkkss..aasspp:

Hasilnya akan seperti berikut ini
apabila dibuka oleh browser.

Penjelasan Scripting ASP :
<% If Request.Form("txtnama") = "" Then

Response.Write "Anda belum mengisi
<b>nama</b> anda"

ElseIf Request.Form("txtemail") = "" Then

Response.Write "Anda belum mengisi <b>e-
mail</b> anda "

ElseIf InStr(Request.Form("txtemail"),"@") =
0 Then

Response.Write "E-mail anda tidak valid"

ElseIf Request.Form("txtkomentar") = "" Then

Response.Write "Anda belum mengisi
<b>komentar</b> anda"

Else%>

Merupakan sebuah konfirmasi untuk
memeriksa apakah semua field baik
Nama, Email, maupun Komentar telah
terisi. Dan juga untuk memeriksa apa-
kah alamat email yang diisi terdapat
karakter '@', karena tanpa karakter '@'
maka alamat email tersebut tidak valid.
<% Dim objFSO, databuku, Path

Path = Server.MapPath("bukutamu.txt")

Set objFSO =
Server.CreateObject("Scripting.FileSystemObjec
t")

Set databuku = objFSO.OpenTextFile(Path, 8)

databuku.WriteLine
Request.Form("txtnama")

databuku.WriteLine
Request.Form("txtemail")

databuku.WriteLine
Request.Form("txtkomentar")

databuku.WriteBlankLines(1)

databuku.Close%>

Kode scripting diatas berfungsi untuk
memasukkan data yang dikirim dari
form ke dalam media penyimpannya.
Set databuku = objFSO.OpenTextFile(Path, 8),
berfungsi membuka file 'bukutamu.txt'
dengan angka 8 merupakan perintah
untuk menambah file append file.

C. File untuk Menampilkan Para
Pengisi Buku Tamu (list.asp)
Ketikkan kode berikut ini ke teks edi-
tor kesayangan anda,lalu simpanlah
dengan nama lliisstt..aasspp..  Hasilnya akan
seperti berikut ini:

<html><head>
<title>Buku Tamu</title>
</head><body>
<h3 align="center">Terima Kasih Atas Partisipasi Anda</h3><hr>
<p align="left"><b>Data Anda :</b><br>
<% If Request.Form("txtnama") = "" Then

Response.Write "Anda belum mengisi <b>nama</b> anda"
ElseIf Request.Form("txtemail") = "" Then

Response.Write "Anda belum mengisi <b>e-mail</b> anda "
ElseIf InStr(Request.Form("txtemail"),"@") = 0 Then   

Response.Write "E-mail anda tidak valid"
ElseIf Request.Form("txtkomentar") = "" Then

Response.Write "Anda belum mengisi <b>komentar</b> anda"
Else %>

<table border="0" width="604">
<tr>

<td width="94">Nama :</td>
<td width="496"><%=Request.Form("txtnama")%></td>

</tr>
<tr>

<td width="94">E-Mail :</td>
<td width="496"><%=Request.Form("txtemail")%></td>

</tr>
<tr>

<td width="94" valign="top">Komentar :</td>
<td width="496"><%=Request.Form("txtkomentar")%></td>  </tr>

</table>
<% Dim objFSO, databuku, Path

Path = Server.MapPath("bukutamu.txt")
Set objFSO = Server.CreateObject("Scripting.FileSystemObject")
Set databuku = objFSO.OpenTextFile(Path, 8)
databuku.WriteLine Request.Form("txtnama")
databuku.WriteLine Request.Form("txtemail")
databuku.WriteLine Request.Form("txtkomentar")
databuku.WriteBlankLines(1)
databuku.Close %>

<p>Telah Masuk ke Daftar Buku Tamu Kami</p>
<%End If%>
</body></html>
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Penjelasan Scripting ASP :
Dim objFSO, Path

Path = Server.MapPath("bukutamu.txt")

Set objFSO =
Server.CreateObject("Scripting.FileSystemObjec
t")

Set bukutamu = objFSO.OpenTextFile(Path, 1)

Berfungsi untuk membuka file
"bukutamu.txt". Angka 1
menunjukkan bahwa file tersebut
dibuka dengan mode baca.
Do While NOT bukutamu.AtEndOfStream

……

Loop

Merupakan struktur kontrol
perulangan pada ASP, dimana
perulangan akan terus dilakukan
selama belum akhir dari
stream.

2. Database Buku Tamu
Seperti halnya membuat
buku tamu dengan file teks
sebagai media penyimpannya,
dalam menggunakan database
pun kita memerlukan
beberapa file. Marilah kita
mulai membuat Buku Tamu
dengan menggunakan
database. File yang harus
disiapkan di antaranya:

FFiillee  AADDOOVVBBSS..IINNCC

File ini berisi konstanta yang diper-

lukan untuk menggunakan metode ADO.
Karena scripting ASP yang akan
kita bahas menggunakan metode
ADO untuk koneksi ke database-
nya.

File ini dapat anda temukan di
C:\Program Files\Common Files\
System\ADO. File ini harus
diikut sertakan dalam folder
localhost anda.

A. Database yang Akan
Menyimpan Data

Database yang akan kita gunakan
adalah Microsoft Access.Untuk mem-
buatnya, ikuti langkah-langkah
berikut:

<html><head>
<title>Buku Tamu</title>
</head><body><p align="center"><font size="5">Daftar Pengisi Buku
Tamu</font></p><hr>
<p><table border="0" width="80%">
<% 
Dim objFSO, Path
Path = Server.MapPath("bukutamu.txt")
Set objFSO = Server.CreateObject("Scripting.FileSystemObject")
Set bukutamu = objFSO.OpenTextFile(Path, 1)
Do While NOT bukutamu.AtEndOfStream
%>

<tr>
<td width="22%">Nama :</td>
<td width="85%"><%Response.Write bukutamu.ReadLine%></td>

</tr>
<tr>

<td width="22%">Email :</td>
<td width="85%"><%Response.Write bukutamu.ReadLine%></td>

</tr>
<tr>    <td width="22%">Komentar :</td>

<td width="85%"><%Response.Write bukutamu.ReadLine%></td>
</tr>
<tr>

<td width="22%"><%Response.Write bukutamu.ReadLine%></td>
<td width="85%">&nbsp;</td>

</tr>
<%Loop
bukutamu.close%>
</table></body></html>

Buka Microsoft Office anda
SSttaarrtt  >>  PPrrooggrraamm  >>  MMiiccrroossoofftt
AAcccceessss  (MSAccess merupa-
kan bagian dari MSOffice).

1

Setelah masuk ke MS Access,
akan tampil window baru.
Pilih ‘Blank Acess Database’
lalu klik OK.

2

Simpanlah file dengan nama
bbuukkuuttaammuu,, lalu klik Create3

Klik dua kali (double click)
'Create table in Design view'4

Isilah kolom Field Name dan
Data Type seperti berikut

Field Name Data Type
nama AutoNumber
email Text
email Text
komentar Text
Tambahan: (1).Untuk 'komentar' isi
Field Size dengan nilai 255. (2).ID'
diset sebagai Primary Key-nya

5



Hasilnya akan tampak seperti berikut :

Penjelasan script ASP:

Dim objConn
Dim objComm
Dim objPar
Dim strSQL
Dim filePath
Dim reqNama
Dim reqEmail
Dim reqKomentar

Bertujuan untuk mendeklarasikan
semua variabel yang akan diguna-
kan dengan menggunakan
statement “DIM.”

reqNama = Request.Form("txtnama")
reqEmail = Request.Form("txtemail")
reqKomentar = Request.Form("txtkomentar")
Mengambil nilai dari masing-
masing komponen yang ada di form
yang terkirim dan di simpan di
masing-masing variabel yang
berbeda.

filePath = Server.MapPath("bukutamu.mdb")
strSQL = "INSERT INTO data (Nama, Email,
Komentar) VALUES (?, ?, ?)"
Set objConn =
Server.CreateObject("ADODB.Connection")
objConn.Open
"Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=" & filePath
Set objComm =
Server.CreateObject("ADODB.Command")

Membuka koneksi ke database
“bukutam” dan menggunakan
perintah untuk memasukkan data
ke dalam masing-masing field yang
ada di dalam database

Set objPar = objComm.CreateParameter(,
adChar, ,50, reqNama)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(,
adChar, ,50, reqEmail)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(,
adChar, ,255, reqKomentar)
objComm.Parameters.Append objPar 
objComm.Execute
objConn.Close

Saatnya untuk mendefinisikan para-
mater yang akan memasukkan data
ke dalam database dengan tipe,
ukuran, dan variabel yang berisi
nilai. Serta menutup koneksi dari
database.
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<html><head>
<title>Buku Tamu</title>
</head>
<body>
<form method="POST" action=thanks.asp>

<p align="center"><font size="5"><b>Buku Tamu</b></font></p>
<hr>
<table border="0" width="62%">
<tr>
<td width="34%">Nama</td>
<td width="66%"><input type="text" name="txtnama" size="37"></td>

</tr>
<tr>
<td width="34%">Email</td>
<td width="66%"><input type="text" name="txtemail" size="37"></td>

</tr>
<tr>
<td width="34%">Komentar</td>
<td width="66%"><textarea rows="6" cols="31" name="txtkomentar"></textarea>

</td>
</tr>

</table>
<p><input type="submit" value="Kirim"> <input type="reset" value="Hapus"></p>

</form>
</body></html>

<html><head>
<title>Buku Tamu</title>
<body>
<table border="0" width="100%">
<tr>
<td width="33%" valign="top" align="center">
<table border="0" width="100%">
<tr>
<td width="100%">
<h2 align="center"><!--#Include File="adovbs.inc"--><%

Dim objConn
Dim objComm
Dim objPar
Dim strSQL
Dim filePath
Dim reqNama
Dim reqEmail
Dim reqKomentar
reqNama = Request.Form("txtnama")
reqEmail = Request.Form("txtemail")
reqKomentar = Request.Form("txtkomentar")
filePath = Server.MapPath("bukutamu.mdb")
strSQL = "INSERT INTO data (Nama, Email, Komentar) VALUES (?, ?, ?)"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" & filePath
Set objComm = Server.CreateObject("ADODB.Command")
objComm.ActiveConnection = objConn
objComm.CommandText = strSQL
'---Definisi Parameter---
Set objPar = objComm.CreateParameter(, adChar, ,50, reqNama)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,50, reqEmail)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,255, reqKomentar)
objComm.Parameters.Append objPar
objComm.Execute
objConn.Close%>

<font color="#800080">Terima Kasih Telah mengisi Buku Tamu
Kami</font></h2>

</td>
</tr>

</table>
</table><p>
<p>&nbsp;</p>
<p align="center"><font size="4">Data Anda Telah Masuk ke dalam Database
Kami</font></p>
</body>

B. Database untuk Menampil-
kan Form (form.asp)

C. File untuk Ucapan Terima
Kasih dan Memasukkan Data
ke Database (thanks.asp)



Hasilnya akan seperti berikut:

Penjelasan skrip ASP
filePath = Server.MapPath("bukutamu.mdb")
strSQL = "SELECT * FROM data"
Set objConn =
Server.CreateObject("ADODB.Connection")
objConn.Open
"Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=" & filePath
Set objRset =
Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic

Membuka koneksi ke database
bukutamu dan mengaktifkan tabel
“data.”

<% For i = 1 to
objRset.RecordCount%></pre>
<table border="0" width="100%">

<tr>
<td width="100%">

Nama : <%=objRset("nama")%><BR>
Email :<%=objRset("email")%><BR>
Komentar :
<%=objRset("komentar")%>&nbsp;
<HR></td>

</tr>
</table>
<%
objRset.MoveNext
If objRset.EOF Then

Exit For
End If
Next
%>

Melakukan perulangan selama
jumlah record, dan menampilkan
record dengan menggunakan tabel
Selamat! Anda telah berhasil mem-
buat buku tamu untuk web anda
sendiri atau untuk orang lain. Kode
HTML diatas dapat anda rubah
sesuai dengan keinginan dan kebu-
tuhan anda, selama perubahan ter-
sebut tidak mengganggu skrip ASP
yang ada. Anda pun dapat mengem-
bangkan skrip0 ASP yang ada agar
buku tamu anda dapat lebih inovatif.
Anda dapat memilih antara dua
pilihan media penyimpanan, dengan
teks ataupun dengan database.

Selamat Berkarya.

Jika ada pertanyaan seputar tutorial
ini anda dapat mengirimkan email
anda ke

david_sugianto2002@yahoo.com
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<html><head>
<title>Buku Tamu</title>
<body><table border="0" width="100%">

<tr>
<td width="33%" valign="top" align="center">

<h2 align="center">
<font color="#800080">
Isi Buku Tamu</font></h2>
<table border="0" width="100%">

<tr><td width="100%"><!--#Include File="adovbs.inc"-->
<%
Dim objConn
Dim ObjRset
Dim filePath
Dim strSQL
Dim i

filePath = Server.MapPath("bukutamu.mdb")
strSQL = "SELECT * FROM data"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" & filePath
Set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic
%>
<CENTER>
<!--Menampilkan data-->
<pre>
<% For i = 1 to objRset.RecordCount%></pre>
<table border="0" width="100%">

<tr>
<td width="100%">

Nama : <%=objRset("nama")%><BR>
Email :<%=objRset("email")%><BR>
Komentar : <%=objRset("komentar")%>&nbsp;
<HR></td>

</tr>
</table>
<%
objRset.MoveNext
If objRset.EOF Then

Exit For
End If
Next
%>
</td></tr></table></body>

D. File untuk Menampilkan Para
Pengisi Buku Tamu (list.asp)
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Konfigurasi jaringan WLAN umumnya terdiri dari:
• PC klien yang tersambung ke Akses Point

(AP) secara wireless.
• Akses point yang menghubungkan jaringan

wireless dan LAN biasa.
• Jaringan LAN 
• Router yang menghubungkan jaringan

LAN ke Internet.
Salah satu peralatan kunci dari jaringan ini
adalah Access Point (AP). AP akan menghu-
bungkan jaringan wireless dan jaringan LAN
biasa yang menggunakan kabel.
Pada kesempatan sini akan diperlihatkan proses
setup sebuah acces point dari Compex. Akan
tampak jelas bahwa proses setup accecs point
tersebut sangat sederhana. Setelah diinstal,
program untuk mensetup akses point compex
terdapat di
Start →Programs →AP Manager →AP Manager

DETEKSI OLEH SOFTWARE
Software akan mendeteksi dan mem-
perlihatkan IP address, network mask
dan default gateway dari komputer
(PC) yang kita gunakan.
Kita dapat mengubahnya jika perlu de-
ngan menekan tombol ‘Change.’

4 6

DETEKSI OTOMATIS
Selanjutnya, software AP Manager akan mencari

secara otomatis AP yang ada di ja-
ringan, kemudian akan menampilkan
alamat IP dan alamat NIC (Network
Interface Card)/MAC Address yang
terdeteksi di jaringan. Jika tidak terde-
teksi maka kita dapat melakukan dua
hal yaitu:
•Men-scan ulang jaringan
•Memasukkan secara manual.

MENGISI IP ADDRESS
Proses memasukan alamat IP secara
manual ke akses point tidaklah sukar.
Akan diperlihatkan MAC address dari
akses point tersebut dan kita dapat
langsung men-set alamat IP yang kita
inginkan. Sangat disarankan untuk
meng-clear IP address terlebih dulu
sebelum men-set IP address.

UPDATE INFORMASI DI AP
Pada saat tombol finish ditekan maka
akan tampak pada layar ada usaha
dari software AP Manager untuk
meng-update informasi di AP
Sangat disarankan, setelah setup ini
dilakukan dengan berhasil, agar
parameter setup yang diberikan di-
save ke file melalui fasilitas save file
yang ada.

MELIHAT AP YANG SUDAH DI-SETUP
Untuk melihat apa yang telah kita set sebelumnya
tidaklah sukar, pada saat semua proses setup telah
berhasil dengan sukses dilakukan, kita akan
melihat SSID yang kita pilih tampil pada layar.

Di samping SSID kita akan lihat
beberapa MAC address (alamat NIC)
dari AP yang memberikan servis pada
SSID tersebut.
Untuk melihat setup masing-masing
AP, kita harus meng-klik pada MAC
address (alamat NIC) dari AP yang
kita ingin lihat setup-nya.

JUGA SETUP WLAN SECURITY
Pada MAC address tertentu, kita dapat
melihat setup Access Point & WLAN
Security.
Pada bagian Access Point, kita dapat
melihat tipe AP, versi firmware, alamat
IP, station name, kanal yang dipakai
dan lain-lain.

MMEEN-N-SSEET AT ACCCCEESSS POS POIINNTT
WWIIRREELELESSS LS LANAN

5
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MENSET NETWORK ID DAN CHANNEL
Setelah MAC Address dan IP addresss
terdeteksi, kita dapat menset Network ID
(SSID) dan channel tempat kita beroperasi.
Network ID (SSID) fungsinya kira-kira
mirip dengan workgroup di network
neighbourhood. Hanya workstation yang
menggunakan SSID yang sama dengan
Akses Point yang dapat berkomunikasi
melalui Akses Point. Kanal (Channel)
yang dapat digunakan 1 s/d 11.

MENSET KEAMANAN JARINGAN
Setelah SSID dan Channel diset, selanjutnya menset

keamanan jaringan. Kita dapat memilih
(1) tanpa keamanan sama sekali, atau
(2) dengan protokol Wired Equivalent
Protocol (WEP) dengan kunci sepan-
jang 40 bit.
Pada AP Compex dapat diset pula
community string untuk Simple
Network Management Protocol
(SNMP). Default-nya adalah private.

AKHIR SETUP
Setelah semua selesai akan diperlihatkan berapa

buah AP yang akan dikonfigurasi, dan
AP tersebut akan membentuk berapa
buah jaringan wireless.
Tekan tombol ‘Finish’ untuk mengirim-
kan semua parameter yang kita buat
agar masuk ke memori AP.

1 3
MEMULAI SETUP ACCESS POINT
Untuk memudahkan proses setup, sa-
ngat disarankan menggunakan fasilitas
File →Build from Network
Setelah pilihan ‘Build from Network’ di-
pilih selanjutnya adalah menekan
tombol ‘Next.’

MEN-SET ACCESS CONTROL
Pada bagian WLAN Security, kita dapat melihat
network ID (SSID), community string untuk
SNMP, apakah AP tersebut open access atau
menggunakan enkripsi WEP dengan kunci 40 bit.

Bagian yang cukup seru, pada bagian
ini kita dapat menset penggunaan
access control agar tidak semba-
rangan alat dapat mengakses ke AP
yang kita miliki.

SETUP ACCESS CONTROL
Proses setup access control tidaklah
sukar, kita dapat meng-add (me-
nambahkan) MAC address work-
station yang akan kita kontrol.
Setelah di tambahkan kita dapat
menset apakah untuk MAC address
tersebut “Access is denied” (tidak di
izinkan), atau “Access is granted” (di
izinkan.)

MENSET MAC ADDRESS
Tampak pada gambar tampilan pada
saat kita menset MAC address dari
klien yang akan dikontrol akses-nya.

AP MANAGER ACCESS POINT
Tampak pada gambar adalah tampilan
awal sebuah AP Manager di Access
Point..

MENGEDIT NETWORK PREFERENCES
Selanjutnya yang perlu dilakukan sebelum men- setup
Access Point adalah mengedit Network Preferences.
Biasanya untuk jaringan privat/tertutup digunakan
network address dari keluarga IP 192.168.*.*; dalam

contoh 192.168.0.0. Network Mask kelas
C 255.255.255.0; tentunya dapat di-
ubah sesuai dengan konfigurasi sub-net
yang ada. Default Gateway disesuaikan
dengan konfigurasi jaringan, khususnya
letak gateway. Pada contoh konfigurasi
di atas, gateway terdapat pada IP 192.168.0.1.
Setelah semua di set, tekan tombol set
agar semua setting yang ada masuk ke
memori di access point.

2
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AGIAN PALING SEDERHANA
dalam instalasi Wireless LAN
adalah setup klien Wireless

LAN di sistem operasi Windows. Pa-
da kesempatan ini akan diperlihatkan
contoh setup klien Wireless LAN
Compex menggunakan Windows.

Setelah software klien wireless diins-
tal maka pada pojok kanan bawah
Windows akan tampak ikon kompu-
ter dengan antena kecil di atasnya
menggunakan layar monitor yang
dapat berubah-ubah warnanya,
kadang-kadang berwarna hijau,
kuning, dan merah.

Arti warna tersebut tidak sukar
untuk ditebak. Warna hijau
menunjukkan bahwa komputer kita
terhubung dengan baik ke access
point, warna kuning jika agak jauh ke
access point dan warna merah jika
tidak berhasil berhubungan dengan
access point.

Untuk melihat lebih rinci konfigurasi
dari card Compex yang kita gunakan,
dapat dengan mudah dilakukan de-
ngan mengklik ikon komputer
berantena di pojok kanan tersebut.

Informasi sambungan (link info)
akan dapat kita lihat seperti kondisi
card apakah sudah berasosisasi
dengan access point tertentu atau
masih melalukan scanning. Jika telah

berasosiasi akan diperlihatkan MAC
address dari access point.

Dapat dilihat kita bekerja pada kanal
berapa maupun kecepatan data yang
digunakan. Dalam gambar card
Compex tersebut bekerja pada kanal
6 dengan kecepatan 11Mbps.

Bagaimana kualitas sambungan
maupun kekuatan penerimaan sinyal
dari access point dapat dilihat
termasuk truput transmisi data dari
pemancar (Tx) maupun penerima
(Rx).

Konfigurasi dapat dilakukan dengan
mudah melalui fasilitas
Configuration.

Kita dapat menset mode operasi yang
akan kita gunakan, mode
infrastructure digunakan jika kita
menggunakan access point.

SSID harus diset sesuai dengan SSID
yang digunakan pada access point
agar kita dapat mengakses jaringan.

Kecepatan pemancar dapat diset pada
kecepatan tertentu atau secara
otomatis card akan memilih
kecepatan mana yang sebaiknya
digunakan.

Kita dapat menset apakah WEP
(enkripsi data) akan diaktifkan atau
tidak.

Kita
dapat

menset
juga

apakah
Power Save

(PS) mode akan
diaktifkan atau

tidak. PS mode biasanya digunakan
pada laptop yang sedang beroperasi
menggunakan batere. Penggunaan PS
mode ini akan menurunkan
performance.

Jika WEP di aktifkan kita pada
menset password yang digunakan
untuk enkripsi maupun kuncinya
sebagai empat buah kombinasi kunci.

Sangat disarankan bagi anda yang
ingin aman untuk menggunakan
teknik virtual private network (VPN)
dengan teknik tunnelling daripada
mengandalkan enkripsi dari WEP ini.

B

Menyetel Klien Menyetel Klien 
WirWirelesseless LLANAN CompexCompex
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engerti dengan baik cara kerja
jaringan komputer, khususnya
Internet, adalah prasyarat

mutlak untuk menjadi seorang hacker
yang baik, bukan sekedar menjadi
kelompok hacker kelas script kiddies
atau click kiddies. Sebetulnya seluruh
teknologi Internet terbuka dan dapat
dibaca dan di-download dengan mudah
di Internet Engineering Task Force
(IETF) (www.ietf.org.)

Khususnya bagi yang kemudian terta-
rik untuk mendalami ilmu per-hacker-
an dapat membaca-baca naskah di
www.sans.org, http://rr.sans.org, dan
www.hackingexposed.com. Beberapa
contoh tool yang sering digunakan di
Linux yang membutuhkan pengetahu-
an yang lumayan tentang teknologi
Internet adalah tcpdump, snort, port-
sentry, freeswan, dll. Memang untuk
sekedar menginstal dan menjalankan-
nya di Linux tidaklah sukar, tetapi un-
tuk mengerti makna dari output atau
tampilan yang dihasilkan oleh soft-
ware tersebut anda harus mendalami
terlebih dahulu teknologi Internet di
www.ietf.org.

Dari sekian banyak tata cara komuni-
kasi (protocol) di Internet, bagi para
pemula, ada baiknya untuk mengerti
dengan baik dua protokol utama
Internet yaitu Internet Protocol (IP).
dan Transmission Control Protocol
(TCP). Tidak heran Internet dikenal
sebagai jaringan TCP/IP. Perlu dipa-

hami bahwa TCP dan IP bukanlah pro-
tokol satu-satunya di Internet, masih
banyak lagi protokol lain yang diguna-
kan untuk membangun Internet, se-
perti ICMP, BGP, OSPF, SNMP, SMTP,
POP, HTTP, SIP dll.

Topologi Sebuah Paket Data
Dimanakah letak protokol tersebut da-
lam sebuah paket data? Untuk menye-
derhanakan masalah, kita lihat topolo-
gi sebuah paket data yang dikirimkan
melalui jaringan LAN menggunakan
ethernet. Secara sederhana, di muka
paket data yang kita kirim biasanya di-
tambahkan secara berurutan header
dari protokol ethernet (IEEE 802.3),
Internet Protocol (IP), dan Transmis-
sion Control Protocol (TCP).

Panjang maksimum paket yang dikirim
tergantung pada Maximum Transmis-
sion Unit (MTU) yang kita set, biasa-
nya di LAN Ethernet di set 1500byte
per paket. Artinya jika kita akan me-

ngirimkan gambar/file 1Mbyte akan
dipotong kecil-kecil sepanjang 1500byte.
Tentunya untuk data pendek yang ku-
rang dari 1500byte akan dengan se-
nang hati dikirim oleh Ethernet tsb.

Jika paket tersebut dikirim melalui sa-
rana fisik yang lain, misalnya paket
radio, wireless LAN, atau satelit, kita
hanya perlu perlu mengganti ethernet
header dengan header protokol yang
cocok digunakan di jaringan fisik tsb.
Misalnya untuk paket radio  digunakan
AX.25, di wireless LAN digunakan
IEEE 802.11a atau IEEE 802.11b, di
satelit digunakan HDLC dsb.

Dalam tulisan ini kita akan fokuskan
pembahasan hanya pada header
Internet Protocol (IP) dan Transmis-
sion Control Protocol (TCP) saja. Sebe-
tulnya, dengan mengetahui header
kita dapat meraba cara kerja protokol
tersebut. Tentunya akan lebih mudah
jika kita membaca langsung naskah
protokolnya di www.ietf.org.

M

MemahamiMemahami
TTCP/CP/IIP HeaderP Header

Dua protokol utama di Internet adalah Transmission Control Protocol (TCP) dan Internet
Protocol (IP). Bagi anda, para calon hacker, Onno W. Purbo menguraikan apa yang dimaksud

dengan header pada TCP/IP untuk mengetahui cara kerja kedua protokol tersebut.

• Topologi paket data
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Internet Protocol (IP)
Header Internet Protocol (IP) panjang-
nya 20 byte. Dalam 20 byte protokol
header tersebut adalah beberapa infor-
masi penting yang menjadi jantung
proses routing dan pola penyampaian
paket dari satu node ke node lain di
jaringan Internet. Informasi penting
yang digunakan untuk proses routing
adalah:

• Source IP Address (32 bit), alamat IP
komputer pengirim data.

• Destination IP Address (32 bit),
alamat IP komputer tujuan.

• Time-To-Live (8 bit), jumlah maksi-
mum router yang dapat dilewati
(maksimum 255 router).

• Protokol (8 bit), memberitahukan
protokol apa yang dibawa di atas IP.
Contohnya adalah TCP dan User
Datagram Protocol (UDP).

Untuk operasi normal biasanya cukup
empat hal tersebut yang diperhatikan.
Untuk operasi tidak terlalu normal,
misalnya kita ingin mengirimkan sua-
ra telepon melalui jaringan Internet
secara reliable maka kita perlu menset
bit pada Type of Service (ToS) yang
jumlahnya 8 bit. Adapun kode atau
kondisi yang diinginkan oleh bit-bit
Type of Service (ToS) dapat anda lihat
pada tabel ‘Format Type of Service
(ToS).’

Dalam bahasa sederhana, misalnya bit
Type of Service yang ada dalam IP
yang kita terima adalah

00111100

mempunyai arti bahwa paket tersebut
harus di prioritaskan dalam antrian di
router, agar memperoleh delay semi-
nimal mungkin, dengan throughput
semaksimal mungkin dan reliabilitas
yang tinggi. Untuk paket yang normal
isi Type of Service adalah 00000000.

IP juga mengontrol apakah data yang
kita kirim dapat di potong menjadi po-

tongan yang lebih kecil, istilahnya di-
fragmentasi. Kontrol apakah paket da-
pat di fragmentasi, dan jika difragmen-
tasi paket tersebut merupakan frag-
mentasi yang ke berapa akan dikontrol
oleh Flag di protokol IP. Adapun isi
tiga bit pertama dari Flag yang kemu-
dian diikuti oleh informasi offset Frag-
mentasi dapat dilihat pada tabel di atas.

Perhatikan baik-baik bahwa tidak ada
informasi tentang routing yang diba-
wa oleh Internet Protocol, yang ada
hanyalah alamat IP sumber dan alamat
IP tujuan. Di samping itu tidak ada me-
kanisme apapun di Internet Protocol
yang bisa menjamin reliabilitas pengi-
riman data. Inilah cantiknya Internet.

Transmission Control Protocol
(TCP)
Transmission Control Protocol (TCP)
beroperasi di atas Internet Protocol
(IP). Untuk operasi normal, kita hanya
perlu memperhatikan

• Source Port (16 bit).
• Destination Port (16 bit).
• Sequence Number (32 bit),

merupakan nomor urut paket.
• Acknowledgement Number (32 bit),

merupakan nomor paket yang sudah
di acknowledge atau sampai dengan
selamat ke tujuan.Bit 0-2 Precedence

111 Normal Control
110 Internetwork Control
101 CRITIC / ECP
100 Flash Override
011 Flash
010 Immediate
001 Priority
000 Routine

Bit 3 Delay
0 normal delay
1 low delay

Bit 4 Throughput
0 normal throughput
1 high throughput

Bit 5 Reliability
0 normal reliability
1 high reliability

Bit 6-7 Reserved

Format Type of Service (ToS)

R bit 0 di reservasi, dan harus 0.

DF bit 1: don't fragment bit
0 paket dapat di fragmentasi.
1 paket jangan di fragmentasi.

MF bit 2: more fraqments bit
0 fragmentasi terakhir
1 masih ada fragmentasi 

selanjutnya.

Flag

• Bagan Internet Protocol (IP)

• Bagan Transmission Control Protocol (TCP)
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Perhatikan bahwa Acknowledgement
Number dan Sequence Number meru-
pakan kunci utama dalam menjamin
reliabilitas pengiriman data menggu-
nakan protokol TCP. Jika ada paket
yang belum diterima atau belum sam-
pai akan dapat dilihat dengan mudah
melalui nomor tersebut.

Nomor port (16 bit) adalah kode port
untuk menentukan aplikasi apa yang
sedang kita gunakan. Bagi pengguna
Internet pasti cukup familiar bahwa
kode port untuk beberapa servis di
bawah ini pasti dikenal dengan baik,

Mail SMTP - port 25
Mail POP3 - port 110
Web HTTP - port 80

Bagi pengguna Linux, daftar lumayan
lengkap dari berbagai port tersebut
dapat dibaca di /etc/services.

Berbeda dengan Internet Protocol (IP)
yang tidak mengenal kondisi sambung-
an (stateless), pada Transmission Con-
trol Protocol (TCP) dikenal state (kon-
disi) sambungan. Yang di maksud kon-
disi sambungan (state) disini, misalnya

• Klien sedang berusaha menghubungi
server.

• Server telah bersedia menerima hu-
bungan komunikasi dengan klien.

• Server dan klien bertransaksi data.
• Server memutuskan hubungan.
• Klien memutuskan hubungan

komunikasi.

Kondisi (state) tersebut di beberapa
kontrol bit, yaitu:

URG (1 bit) - paket yang sifatnya      
urgent (penting).

ACK (1 bit) - acknowledge, paket
diterima dengan
baik.

PSH (1 bit) - Push, memaksa.

RST (1 bit) - Reset, mereset
hubungan.

SYN (1 bit) - sinkronisasi, untuk
membuka hubungan
awal.

FIN (1 bit) - Final, memutuskan
hubungan.

Beberapa contoh skenario dalam pema-
kaian bit kontrol adalah sebagai berikut,

• Klien mengirimkan SYN ke Server,
menandakan klien meminta hubung-
an dengan server.

• Server menjawab dengan mengi-
rimkan ACK SYN, artinya Server
siap menerima hubungan.

• Server dapat juga menjawab dengan
mengirimkan PSH RST FIN, artinya
Server memutuskan hubungan de-
ngan Client dan tidak bersedia mene-

rima hubungan.
• Jika hubungan te-

lah terjalin, biasa-
nya hanya digu-
nakan bit kontrol
ACK atau PSH
ACK untuk mem-
berikan acknow-
ledgement bahwa
paket nomor ter-
tentu telah dite-
rima dengan baik.

Jika anda mengerti
betul konsep state
dan kontrol bit ter-
sebut, tidaklah sukar
untuk mengerti kon-
sep Stealth Scanning
yang sering diguna-
kan oleh para hacker
untuk mencek servis
apa saja yang dija-
lankan oleh sebuah
server di Internet
sebelum serangan
dilakukan.

TCP Checksum (16
bit) digunakan un-
tuk kode cek apakah
paket yang dikirim
masih utuh sampai
di tujuan atau ada
kerusakan. Jika ma-
sih utuh maka paket
ACK akan dikirim-
kan oleh penerima ke pengirim.

Window size (16 bit) merupakan usaha
untuk mengefisienkan penggunaan ja-
ringan dengan cara mengirimkan bebe-
rapa paket sekaligus tanpa menunggu
ACK terlebih dulu. Untuk kondisi yang
tidak terlalu reliable biasanya TCP akan
mengirimkan sebuah paket ke tujuan
dan menunggu ACK dari tujuan sebe-
lum mengirimkan paket selanjutnya.
Konsekuensinya akan ada jeda (delay)
yang lumayan (bisa beberapa ratus
milidetik) antara satu paket dengan
paket lainnya.

Dengan konsep sliding window yang
diset maksimum pada window size (16
bit), kita dapat menset window size be-
berapa kali panjang Maximum Trans-
mission Unit (MTU). Misalnya MTU
1500byte, kita dapat menset window size
6000 byte. Artinya apa? Jika pada saat
pengiriman data TCP melihat bahwa
jaringan cukup reliable, artinya tidak ada
paket yang hilang / rusak di jalan dan
ACK selalu dikirimkan oleh penerima
dengan tepat waktu maka TCP akan
berusaha mengirimkan beberapa (2-4)
paket sekaligus tergantung panjang
window size tanpa menunggu ACK dari
penerima terlebih dulu.

Tentunya proses menaikkan jumlah pa-
ket yang dikirim sekaligus dilakukan
secara bertahap, jadi berawal dari satu (1)
paket jika ternyata baik maka akan
dicoba dengan dua (2) paket, jika sam-
bungan masih baik di coba lagi dengan
tiga (3) paket dst. Jika terjadi kerusakan
pada paket, artinya ACK tidak diperoleh
pada waktunya, maka TCP langsung
menurunkan lagi paket menjadi satu (1)
paket lagi, dan secara bertahap dinaikkan
lagi jika sambungan di rasakan reliable.
Konsep naik turunnya jumlah paket
yang dikirimkan secara otomatis ini
dinamakan sliding window.

Tentunya ada beberapa mekanisme
lain yang tidak ada pada header
protokol TCP tapi juga penting untuk
menjamin reliabilitas pengiriman data,
yaitu, konsep TCP back off yang me-
nentukan kapan pengiriman ulang
sebuah paket yang rusak harus
dilakukan.

Berbeda dengan Internet Protocol (IP)
yang sama sekali tidak menjamin re-
liabilitas pengiriman data. Transmis-
sion Control Protocol (TCP) berusaha
secara maksimal agar proses pengi-
riman data andal dan efisien.

Layer Unit Pandangan Keterangan

1 Physical bit wire Melewatkan bit-bit 
melalui wire.

2 Data Link frame next Kegunaan next hop
hop untuk menghubungkan

komputer dengan 
router, atau dua router.

3 Network packet mesin Network layer adalah 
lain IP. Di sinilah layer 

‘pertama’ sesung-guhnya.
IP protocol dirancang se-
putar konsep ‘unreliable
datagram.’ Setiap mesin
diberi IP address. Mesin 
menempatkan address 
itu pada paket yang diki-
rim ke router terdekat.

4 Transport koneksi program Trasport layer adalah
lain TCP (dan UDP)

5 Session Didefinisikan tapi 
tidak jelas keguna-
annya.

6 Presentation Application layer tidak 
perlu memformat data 
untuk transmisi wire.

7 Application file user Protokol untuk aplikasi
transaction tertentu, misalnya http
command untuk web browser,

smtp/pop/imap untuk
email.

OSI 7-Layer Model
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Privasi AndaPrivasi Anda
Anda menyimpan data rahasia di PC anda? Khawatir akan ada 'tangan jahil' yang mengutak-atiknya?

Lindungi berkas dan bahkan seluruh PC anda dengan mengikuti petunjuk berikut.

MenjagaMenjaga

ASALAH KEAMANAN KOMPUTER
dewasa ini sudah makin ru-
mit. Pada komputer pribadi,

yang namanya keamanan komputer
lebih sulit dijaga. Setiap orang bisa
saja menghidupkan PC mana saja dan
langsung menggunakannya. Sedang-
kan yang dibanggakan sebagai kata
sandi BIOS dan kata sandi pelindung
dokumen dengan mudah dibongkar
orang. Artikel ini diharapkan dapat
membantu anda untuk memperkuat
'pertahanan' di PC anda, walaupun
tidak dapat menjamin aman 100%.
Konsep komputer yang benar-benar
tidak dapat ditembus adalah nonsens
karena pengaman apa pun selalu dapat
dicari lubang kelemahannya.

Mencegat di Boot
Saat ini orang berpikir perlu melin-
dungi komputernya bahkan saat kom-
puter itu baru diaktifkan. Dari sinilah
lahir yang disebut kata sandi (password)
BIOS. Artinya sebuah kotak pop-up
muncul setelah komputer dihidupkan
dan selesai mentes memori serta meng-
identifikasi disk. Tanpa kata sandi
yang benar, PC anda tidak akan boot.

Tetapi ternyata upaya perlindungan bri-
lian ini amat mudah dikecoh. Orang
dapat membuka CPU komputer anda
dan mengangkat batere BIOS di mother-
board untuk beberapa detik sehingga
BIOS akan di-reset dan kehilangan
kata sandinya.

Setelah merampungkan kerja penge-
tesannya, BIOS beralih ke sektor boot

hard disk untuk sebuah
program kecil yang akan
mengawali pemuatan sistem
operasi komputer. Jadi
inilah langkah selanjutnya
yang dapat dipayungi pe-
lindung. Untuk ini ada
beberapa boot loader yang
terutama dirancang untuk
memungkinkan anda
berpindah dari dua atau
lebih sistem operasi yang
diinstal di PC anda (seperti
Linux dan Windows). Di
sini anda pun bisa me-
masang langkah pemasukan
kata sandi.

Boot loader gratisan XOSL
adalah salah satu contohnya dengan
alamat situs www.xosl.org. Anda dapat
menjumpai program ini pada CD
Neotek bulan ini. XOSL adalah
program yang rumit sehingga
instalasinya bisa memusingkan anda.
Manualnya yang cukup lengkap
rasanya perlu anda baca.

Mengunci Windows
Setelah Windows berjalan, anda mem-
punyai lebih banyak lagi kesempatan
untuk memproteksi data anda. Yang
pertama tentu saja berupa upaya men-
cegah orang yang tidak mempunyai
menggunakan keseluruhan Windows
atau hanya program tertentu.

Winsecure-IT memberikan perlindung-
an semacam Windows-NT terhadap
PC anda. Artinya anda dapat menggu-

nakan utilitas ini untuk
mengunci desktop atau
Windows saat dijalankan.
Ketika Winsecure-IT
dijalankan untuk pertama
kali, anda diminta
memasukkan kata sandi
yang tentu saja tidak boleh

anda lupa. Tidak seperti program
sejenisnya, anda tidak dapat menghin-
dar dari Winsecure-IT dengan menekan
Ctrl+Alt+Del (ketiga tombol ini dinon-
aktifkan saat Winsecure-IT berjalan),
sedangkan kata sandi anda disimpan
dalam bentuk terenkripsi sehingga
tidak ada orang yang dapat mencari-
nya di registry atau file .ini.

Trik berikutnya yang dapat anda coba
adalah dengan menolak akses orang
lain terhadap program dan/atau fungsi
tertentu di dalam Windows. Paling ti-
dak, walaupun mereka dapat melihat
berkas (file) di PC anda, anda dapat
mencegah mereka menggunakan apli-
kasi viewer yang diperlukan (misalnya
Microsoft Word untuk dokumen teks)
dan mencegah mereka menggunakan
perangkat Windows yang diperlukan
untuk menyalin (copy) berkas dari PC
anda ke disket, misalnya.

WinGuard Basic memungkinkan anda
mengunci My Computer. Artinya jika
ada orang yang tidak memiliki kata
sandi yang seharusnya maka ia tidak
dapat mengakses drive anda yang ma-
na pun. Ini berarti mereka pun tidak
dapat menyalin berkas dari dan ke PC
anda. Anda juga dapat mengunci me-
nu Shutdown sehingga jika si usil men-
coba mem-boot ulang komputer anda
untuk melumpuhkan WinGuard, ia
akan menghadapi nasib yang sama.

M

• XOSL bekerja sebelum sistem
operasi PC anda masuk. Jika
anda memproteksi PC anda
dengan kata sandi, maka tidak
akan ada orang yang dapat
mengganggunya.

• Winsecure-IT dapat mengunci komputer anda sesuai
permintaan dan mencegah orang menjalankan Windows

tanpa kata sandi yang seharusnya.
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Password Protection System Lite ada-
lah program gratisan yang dapat me-
ngunci file .exe di PC anda. Pengguna-
annya sederhana. Program ini tidak
perlu diinstal tetapi disalin ke sebuah
folder pada hard disk anda. Program
ini pun tidak perlu bertengger di
memori pada saat menjalankan pro-
gram yang diproteksi dengan kata
sandi. Program ini pun dapat anda
jumpai pada CD Neotek bulan ini.

Untuk menggunakan program ini,
buka file zip-nya dan jalankan pps-
lite.exe. Klik File pada bagian kanan
atas untuk memilih program ini (anda
harus mem-browse-nya secara manual
untuk menemukan dengan menggu-
nakan My Computer—kebanyakan
program ditempatkan di direktori
Program Files). Selanjutnya ketikkan
kata sandinya di kotak di bawah nama
file dan klik tombol Add Pass.

Berkas dan Folder
Tidak ada satu pun metode yang dibi-
carakan di depan yang dapat mena-
warkan perlindungan yang benar-
benar ampuh. Setiap proteksi dengan
mudah dapat dibongkar dengan hanya
secuil pengetahuan.

Proteksi data, oleh karena itu, harus
diarahkan juga pada ujung dari semua
perlindungan itu yaitu berkas atau file
itu sendiri, tempat anda menyimpan
semua data penting anda. Dan sebe-
narnya di sinilah proteksi yang paling
efektif dapat diterapkan.

Metode pertama adalah menyembu-
nyikan berkas dimaksud. Ini dapat
dilakukan dengan ‘menghilangkan’
folder tempat menyimpan file itu.
Happy Chandraleka menguraikan tiga
cara menyembunyikan folder pada
NeoTek nomor ini yang dapat anda
ikuti karena caranya mudah dan
praktis.

Di samping utilitas Folder Guard
untuk menyembunyikan folder, seper-
ti yang dibahas Chandraleka, masih
ada program lain bernama Hide Fold-
ers. Anda dapat menggunakan Hide
Folder untuk menyembunyikan ber-
kas dan, sudah barang tentu, memun-
culkannya kembali. Setelah diinstal
program ini mudah digunakan—klik
ikon di kanan atas dan browse folder
yang akan anda sembunyikan.

Pilihan lain yang dapat anda pertim-
bangkan adalah KPKfile. Cara yang
digunakan program ini agak berbeda.
Anda dapat membuat direktori untuk
menempatkan berkas-berkas sesuai
dengan yang anda kehendaki. Setelah
selesai, katakanlah anda kemudian ingin
meninggalkan meja kerja anda untuk

suatu urusan, anda dapat 'menutup'
folder ini dan pada saat itulah KPKFile
akan mengambil isinya, menempatkan-
nya pada sebuah file besar, lalu mengen-
kripnya. Sudah barang tentu jika anda
ingin mengaksesnya kembali, anda
harus 'membuka' direktori tersebut
yang akan didekrip oleh KPKfile.

Satu alternatif lain dari menyembunyi-
kan berkas adalah dengan menyusup-
kannya pada berkas lain, seperti ber-
kas grafis atau musik .mp3. Berkas yang
dipakai untuk ‘bersarang’ ini masih
dapat menjalankan fungsi utamanya
(berkas .mp3 tetap dapat mendendang-
kan lagu). Satu-satunya petunjuk bah-
wa ada berkas lain yang diselundup-
kan ke dalamnya adalah ukurannya
yang sedikit lebih besar.

Camouflage-lah yang memungkinkan
anda melakukan hal ini. Penggunaan-
nya pun mudah. Setelah program di-
instal, klik kanan pada berkas mana
saja yang akan anda sembunyikan di
dalam berkas lain. Dengan mengklik
Next, anda akan diminta menentukan
berkas mana yang akan dipakai seba-
gai sarang persembunyian. Tidak lupa,
anda pun akan diminta memasukkan
kata sandi.

Tetapi ada satu hal yang harus anda
perhatikan. Jika berkas yang dibuat
lewat Camouflage itu dibuka untuk
editing (katakan jika itu berkas .jpg
dibuka dengan Paint Shop Pro), maka
program itu kemungkinan besar akan
membuang file yang anda sembunyi-
kan karena menganggapnya hanya
sebagai data sampah.

Enkripsi
Bentuk proteksi terakhir yang rasanya
paling efektif adalah enkripsi. Enkripsi
bekerja dengan mengenkode isi berkas
berdasarkan rumusan matematis yang
rumit yang disebut 'key.' Key-key ini
dibuat secara acak pada PC anda
berdasarkan frasa sandi yang anda ma-
sukkan. Karena panjangnya enkripsi
yang dibuat maka kemungkinan orang
dapat menerka key anda adalah ber-
milyar berbanding satu. Jangan salah,
superkomputer sekalipun hampir ti-
dak mungkin meng-crack berkas yang
dienkrip oleh perangkat lunak enkrip
yang paling sederhana sekalipun.

3eee Triple Encryption Small Client
adalah program enkripsi gratisan.
Setelah diinstal, utilitas ini menawar-
kan pilihan baru pada menu klik-
kanan anda—3eee Encrypt File. Jika
menu ini diklik, anda diminta mema-
sukkan passkey yang bisa berupa kum-
pulan kata, atau mungkin frasa yang
dapat dihapal. Makin panjang frasa
yang dimasukkan, maka makin 'aman'
dan makin sulit pula enkripsi itu
dipecahkan.

Setelah enkripsi rampung, sebuah ber-
kas baru akan dibuat. Anda kemudian
dapat menghapus berkas aslinya dan
menyimpan file enkripsinya. Tetapi
ingat-ingat bahwa jika anda sampai
lupa passkey anda maka berarti anda
kehilangan berkas anda. Anda dapat
mendekrip berkas yang dienkrip dengan
3eee dengan mengklik kanan berkas
itu dan memilih 3eee Decrypt File.

Semua kata sandi yang anda gunakan di
Windows disimpan pada berbagai berkas .pwl.
Namun, seperti yang mungkin sudah dapat
anda terka, mendapatkan kata sandi Windows
itu bukanlah pekerjaan sulit. PW Cache
adalah sebuah program gratisan yang dapat
menangkap kata sandi dan menunjukkan
kepada anda apa persisnya isi si kata sandi.

Sudah barang tentu jika anda memilih suatu
kata sandi, akan selalu ada risiko ditebak orang.
Kata sandi yang lazim digunakan orang adalah
nama pasangan atau anak, nama gadis ibu, kata
umpatan, atau kata seperti ‘fred’ atau ‘edward’
(keduanya dapat mudah diketik dengan satu
tangan). Ada orang yang cerdik dengan
menggandakan kata yang digunakan sebagai
kata sandi (misal, ‘fredfred’) atau
menambahkan angka pada kata sandinya
(misal, ‘fred7’). Kadang, agar mudah
mengingat, orang menggunakan ‘username’
mereka sebagai username dan ‘password’
sebagai password (kata sandi)!

Tidak perlu diragukan, untuk membuat kata
sandi tidak perlu harus mengusung seorang
cracker ulung. Buckshot Basic adalah

program gratis yang dapat membantu anda
menghasilkan kata sandi secara acak. Tentu
saja anda kemudian harus mempelajari
hasilnya terlebih dahulu, tetapi ini
memperkecil kemungkinan kata sandi anda
ditebak orang. Penggunaannya sangat
sederhana, tetapi walaupun gratis, anda harus
mendaftarkan penggunaannya sebelum dapat
menggunakan program ini.

Siapa bilang kata sandi aman?

• Buckshot Basic dapat menghasilkan kata sandi
secara acak yang sukar diterka.
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ali ini penulis mencoba
memberikan saran dalam
upaya meningkatkan

keamanan pada folder pembaca
dengan menggunakan perangkat
tambahan dari luar. Perangkat
tambahan tersebut adalah Folder
Guard yang merupakan produk
dari Winability.

Folder Guard yang dibahas di sini
adalah versi 5.3a Standard. Pro-
gram ini cukup handal untuk
meningkatkan keamanan pada
tingkat folder. Dan yang jelas versi
evaluasinya gratis alias tidak bayar
dengan kemampuan yang sama

MMEENNGGAMANAMANKKAN FAN FOOLDLDEERR
DDEENNGGAN FAN FOOLDLDEER GR GUUARARDD
IINNSSTTALALAASSII
Folder anda yang berisi berkas atau file penting mungkin perlu
dilindungi agar tidak dapat sembarang dibuka orang lain. Happy
Chandraleka mengajak anda memberi penjagaan pada folder
anda dengan menggunakan utilitas Folder Guard.

K

MENENTUKAN FOLDER
Pada langkah ini anda diminta
menentukan folder untuk
menginstal file-file Folder
Guard. Gunakan tombol
Browse untuk menentukan
lokasi yang lain. Setelah itu
tekan tombol ‘Next’ dan ‘Yes.’

INSTALLATION OPTIONS
Pada bagian Installation Options
anda disarankan memilih
membuat shortcut pada Start
menu dan Desktop. Selanjut-
nya tekan saja tombol ‘Next.’

DOWNLOAD FOLDER GUARD
Jalankan browser dan arahkan
ke situs Winability (www.
winability.com) untuk mem-
peroleh Folder Guard. Down-
load Folder Guard Standard
dengan mengklik fgstd.zip.
File ini berukuran 672 KB.

TENTUKAN FOLDER
Anda akan dihadapkan pada
tampilan kotak dialog untuk
menentukan folder tempat
menyimpan file fgstd.zip
tersebut. Tekan tombol ‘Save’
dan proses download akan
dimulai.

1

7 8

2

Mencari dan menginstal Folder Guard

EKSTRAK FILE FGSTD.ZIP
Klik ganda file zip tersebut un-
tuk mengekstraknya, lanjutkan
dengan menekan tombol ‘Extract’
pada jendela Winzip atau Anda
dapat menempuh cara cepat
menginstalnya dengan
menekan tombol ‘Install.’

SUDAH SIAP?
Bila masih ada yang perlu di-
ubah, anda dapat mengguna-
kan tombol ‘Back’ untuk me-
modifikasi setting sebelumnya.
Bila sudah siap, tekan tombol
‘Finish’ untuk memulai proses
instalasi.

3

9
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dengan versi registered-nya. Tentu
saja akan ada nag screen.

Biasanya bila kita akan menyembu-
nyikan sebuah file atau folder maka
kita dapat mengubah propertinya
menjadi hidden. Tetapi akan timbul
masalah bila pada Folder Options
diaktifkan pilihan Show All Files,
maka file atau folder yang hidden pun
akan tampak pada layar Windows
Explorer.

Dengan menggunakan Folder Guard,
pembaca dapat membuat suatu folder
menjadi tidak terlihat oleh semua
aplikasi, baik Windows Explorer, MS
Office, MS-DOS program, common

dialogs, dll. Folder Guard juga dapat
digunakan untuk membuat “read-
only,” dan mengontrol akses ke file-
file sistem yang penting, Control
Panel, dan masih banyak lagi. Pro-
gram yang andal ini dapat berjalan
pada sistem operasi Windows
XP/2000/NT/Me/98/95.

PROSES INSTALASI
Setelah menekan tombol
‘Finish,’ proses instalasi akan
dimulai. Anda cukup menung-
gu saja (sambil duduk manis).
Proses instalasi hanya berlang-
sung kurang dari satu menit,
kok.

CONGRATULATIONS
Proses instalasi berakhir dengan
tampilnya kotak dialog yang
berisi ucapan selamat bahwa
Folder Guard telah terinstal
dengan baik. Selanjutnya tekan
tombol ‘Yes’ untuk menjalan-
kan program.

WELCOME!
Selanjutnya akan tampil kotak
dialog selamat datang dari Fol-
der Guard. Klik tombol ‘Next’
dan ‘Yes’ untuk membaca file
Readme. Tutup dokumen
Readme itu dan tekan lagi
tombol ‘Next.’

LICENSE AGREEMENT
Kemudian akan tampil ‘License
Agreement.’ Anda hanya mem-
punyai satu pilihan, tekan tom-
bol ‘Yes’ untuk melanjutkan
proses instalasi.

4

10 11

5 OPERATING MODE
Selanjutnya tampil kotak dialog
yang menanyakan modus
Folder Guard yang akan di -
instal. Anda cukup mengaktif-
kan pilihan ‘Evaluation’ alias
tidak bayar. Kemudian tekan
tombol ‘Next.’

SPLASH SCREEN
Sebuah tampilan selamat
datang atau splash screen dari
Folder Guard akan hadir de-
ngan warna abu-abu dan biru
dan bergambar kepala seorang
prajurit (guard) Inggris.

6

12

Folder Pada lingkungan
graphical user interface
(GUI) seperti Windows dan
Macintosh, folder adalah suatu objek yang
dapat berisi beberapa dokumen. Folder
digunakan untuk menata informasi. Pada
dunia DOS dan UNIX, folder disebut direktori
(directory).

Property Properti adalah ciri dari suatu
objek. Pada banyak bahasa pemrograman,
istilah properti digunakan untuk menjelaskan
atribut yang berkaitan dengan suatu struktur
data. 

DDAFAFTTARAR
IISSTTIILLAHAH
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etelah pembaca menge-
tahui cara menginstal
aplikasi Folder Guard

dengan baik, maka kita dapat
langsung “terjun” ke dalam con-
toh penggunaan Folder Guard
untuk mengamankan folder data
pribadi kita. Pada tutorial ini di-
asumsikan folder yang akan dipro-
teksi adalah folder Neotek yang
memuat data-data yang amat
penting. Setelah pembaca paham
cara mengamankan folder ini,
pembaca dapat menerapkannya
secara riil pada folder pribadi
pembaca.

MMEENNGGAMANAMANKKAN FAN FOOLDLDEERR
DDEENNGGAN FAN FOOLDLDEER GR GUUARARDD
COCONNTTOOH KH KAASSUUSS
Folder anda yang berisi berkas atau file penting mungkin perlu
dilindungi agar tidak dapat sembarang dibuka orang lain. Happy
Chandraleka memberi contoh pengamanan itu dengan
menggunakan utilitas Folder Guard.

S

MENGAKTIFKAN PROTEKSI
Pilih menu Tools → Enable Pro-
tection atau CTRL+G untuk
mengaktifkan perubahan yang
telah anda lakukan pada Lang-
kah 6. Tekan tombol Yes pada
konfirmasi yang tampil untuk
menyimpannya. Buka Explorer
lagi untuk melihat perubahannya.

KASUS LAIN
Pindahkah satu atau beberapa
file untuk percobaan (misal
forest.bmp dan carved stone.bmp
dari folder Windows) ke folder
Neotek.

BUAT FOLDER “NEOTEK”
Jalankan Windows Explorer
dan buat sebuah folder baru
dengan nama “Neotek” untuk
kelinci percobaan. Gunakan
menu File → New → Folder
pada aplikasi Windows
Explorer.

JALANKAN FOLDER GUARD
Jalankan aplikasi Folder Guard
dengan mengklik menu Start
→ Programs → Folder Guard
→ Folder Guard, sehingga
jendela aplikasi Folder Guard
akan memenuhi layar monitor.

1

7 8

2

Praktik penggunaan Folder Guard di komputer anda.

MEMASANG 
PASSWORD ADMINISTRATOR
Pertama buat password admi-
nistrator. Klik menu File →
Password → Administrator's.
Gunanya agar Folder Guard ha-
nya digunakan oleh orang yang
mengetahui password-nya saja.

NO ACCESS
Pada jendela Folder Guard, klik
kanan di folder Neotek dan
pilihlah menu Access → No
access. Maksudnya user dapat
melihat file-file pada folder
Neotek tetapi tidak dapat
mengaksesnya/membukanya.

3

9
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Aplikasi Folder Guard buatan
Winability yang digunakan di sini
adalah versi 5.3a Standard dan
merupakan versi evaluasi (unli-
censed). Oleh sebab itu akan terdapat
nag screen atau tampilan peringatan
kepada user untuk membelinya. Nag
screen-nya cukup mengganggu
terlebih lagi dengan adanya kon-
firmasi yang memungkinkan orang
lain untuk menonaktifkan proteksi
pada folder-folder yang telah pembaca
buat sebelumnya. Untuk itu setelah
mengetahui kehandalan program ini
penulis sarankan untuk meregister
alias membeli Folder Guard.

Lewat uraian langkah per langkah di
bawah ini anda akan mengetahui
‘kesaktian’ si penjaga folder ini dalam
melindugi folder dari tangan-tangan
iseng yang mungkin bermaksud
mengutak-atik data atau file penting
anda, di kantor maupu di rumah.

Tanpa basa-basi lagi mari kita coba
langkah per langkah pengunaan
Folder Guard.

LOCK
Lanjutkan dengan mengunci
folder Neotek dengan mengklik
kanan pada folder tsb dan
memilih menu Lock/Unlock
Password. Kemudian lengkapi
isian password-nya dan tekan
tombol OK.

ENABLE PROTECTION
Aktifkan proteksi dengan memi-
lih menu Tools → Enable
Protection. Lanjutkan dengan
menekan tombol Yes untuk
menyimpan perubahannya.

ADMINISTRATOR'S PASSWORD
Setelah kotak dialog Adminis-
trator's Password tampil, isikan
password anda pada kotak New
Password dan Confirm New
Password. Kemudian tekan tom-
bol OK sehingga tampil kotak
informasi, tekan lagi tombol
OK.

MENENTUKAN FOLDER
“KELINCI PERCOBAAN”
Ekspan My Computer dengan
mengklik tanda tambah di sam-
ping My Computer. Dan tentu-
kan folder untuk “kelinci perco-
baan” dalam contoh ini adalah
folder Neotek yang telah dibuat
sebelumnya.

4

10 11

5 MENYEMBUNYIKAN 
FOLDER NEOTEK
Untuk menyembunyikan folder
Neotek, klik kanan pada folder
tsb, kemudian pada menu pop
up yang tampil pilih menu
Visibility → Hidden. Ikon folder
Neotek akan diberi tanda
silang merah.

PENGUJIAN
Uji dengan menjalankan aplikasi
grafis semisal Paint dan memilih
menu File → Open. Akan ada
peringatan bahwa diperlukan
izin untuk membuka file pada
folder tsb. Untuk itu klik kanan
di folder Neotek pada Explorer
dan pilih menu Unlock.

6

12

• Nag screen seperti gambar di samping
kanan ini akan muncul dan cukup

mengganggu kenyamanan anda jika anda
menggunakan versi unlicensed dari utilitas ini.
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anyak jalan menuju
Roma, demikian pepatah
mengatakan.Demikian

juga halnya dengan perlindungan
terhadap folder anda. Selain de-
ngan menggunakan utilitas Folder
Guard seperti yang dibahas sebe-
lumnya, anda pun dapat meng-
amankan folder anda dengan
mengutak-atik registry.

Pada artikel kali ini penulis
mencoba memberikan sebuah trik
untuk mengamankan folder data
dari pantauan orang-orang yang
tidak berhak. Kiat yang sederhana
ini memerlukan modifikasi

MMEENNGGAMANAMANKKAN FAN FOOLDLDEERR
DDEENNGGAN AN 
MMOODDIIFFIIKKAASSI RI REEGGIISSTTRRYY
Ubah registry pada Windows anda untuk melindungi folder anda.
Happy Chandraleka memberikan tip modifikasi registry untuk
menutup opsi folder pada Windows Explorer.

B

MENYEMBUNYIKAN FOLDER
Klik kanan folder Neotek
tersebut dan pilih Properties.
Beri tanda cek pada atribut
Hidden dan tekan tombol Apply
kemudian Close.

SETTING OLDER OPTIONS
Tampilkan kotak dialog Folder
Options dari aplikasi Windows
Explorer dengan memilih menu
View → Folder Options. Pilih tab
View. Pada kotak Advanced
Settings beri tanda cek pada
pilihan “Do not show hidden
files.” Klik tombol Apply dan OK.

BUKA REGEDIT
Jalankan Regedit dengan me-
nekan menu Start kemudian
Run. Setelah tampil kotak dia-
log Run, ketikkan "Regedit" pa-
da kotak Open. Selanjutnya te-
kan tombol OK, dan jendela
Registry Editor akan tampil
memenuhi layar monitor.

KEY REGISTRY WINDOWS
Selanjutnya buka key berikut:
Hkey_Current_User \ Software
\ Microsoft \ Windows \ Cur-
rentVersion \ Policies \ Explor-
er. Bila terdapat sub key yang
belum ada anda dapat mem-
buatnya dahulu dengan menu
Edit > New > Key.

1
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2

Mengubah registry agar folder terlindungi.

MEMBUAT KUNCI PEMBUKA
Sorot key Explorer tersebut dan
pilihlah menu Edit → New →
DWORD Value. Beri nama
dengan “NoFolderOptions”.
Biarkan value-nya berisi nilai
“0” yang berarti “false”.

RESTART WINDOWS
Restart komputer, sehingga efek
perubahan registry dapat terli-
hat. Tekan tombol Start→ Shut
Down. Pilih opsi Restart dan
sambil menekan Shift, klik tombol
OK. Ini trik untuk me-restart
komputer tanpa perlu kembali
ke BIOS dan DOS.

3

9
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registry Windows untuk menutup
(menghilangkan) menu Folder
Options pada aplikasi Windows
Explorer. Folder Options merupakan
suatu kotak dialog yang di antaranya
mengatur fungsi visibilitas file dan
folder. Ditampilkan atau tidaknya
sebuah folder atau file pada Windows
Explorer diatur oleh kotak dialog ini.
Untuk itu, anda dapat membuat
perubahan pada key pada registry
Windows anda. Dengan mengisikan
value pada “NoFolderOptions” pada
salah satu key di sana, anda telah
menutup opsi folder sehingga tidak
dapat diakses lewat Windows
Explorer.

Pada contoh kasus ini, diasumsikan
folder yang akan diamankan adalah
folder bernama “Neotek” yang
memuat data-data penting yang tidak
boleh diketahui oleh orang lain. Lewat
latihan ini anda dapat menyembunyi-
kan folder “Neotek” tersebut, tetapi
juga dapat membukanya kembali
dengan file berekstensi .reg yang
telah dibuat sebelumnya.

FOLDER TELAH DIAMANKAN
Setelah masuk kembali ke Win-
dows, anda akan mendapati
bahwa folder Neotek tidak ada
karena telah di-hide, demikian
juga menu Folder Options
pada Explorer. Folder telah
diamankan.

MENGEMBALIKAN KE AWAL
Untuk mengembalikan menu
Folder Options yang “hilang,”
carilah file Pembuka.reg pada
folder My Documents. File inilah
yang anda buat pada Langkah 3
dan 4.

MENGEKSPOR REGISTRY
Masih pada key Explorer yang
tersorot, tekan menu Registry
→ Export Registry File. Pada
kotak dialog yang ditampilkan,
beri nama “Pembuka” pada
bagian File name. Tekan
tombol Save.

MENGUNCI FOLDER OPTIONS
Klik ganda dword value “No-
FolderOptions” sehingga mun-
cul kotak dialog Edit Dword Va-
lue. Isikan “1” pada kotak Value
data. Akhiri dengan menekan
tombol OK. Efeknya adalah ti-
dak akan ada menu Folder Op-
tions pada Windows Explorer.

4

10 11

5 JALANKAN WINDOWS
EXPLORER
Tutup Registry Editor dan buka
Windows Explorer. Kemudian
buat folder baru dengan menu
File → New → Folder. Beri
nama dengan “Neotek,”
misalnya.

PENGUJIAN
Klik ganda file Pembuka.reg. An-
da akan dihadapkan pada kotak
konfirmasi penambahan infor-
masi ke registry. Cukup tekan
tombol Yes sehingga tampil pem-
beritahuan bahwa informasi
telah sukses ditambahkan pada
registry. Restart komputer.

6

12

• Inilah tampilan pertama jendela Registry
Editor. Key yang dimodifikasi untuk keperluan

proteksi terhadap folder adalah
HKEY_CURRENT_USER.
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3 LIHAT FOLDER BARU
Ketikkan perintah "dir" untuk
melihat daftar file dan direktori
yang ada pada drive C:\ . Pembaca
akan melihat sebuah direktori yang
baru yang dibuat pada Langkah 2.
Direktori ini agak menjorok ke
dalam sejauh satu karakter.

atu isu yang cukup mendasar dalam
bekerja dengan komputer adalah
keamanan data. Terlebih lagi bila

komputer yang kita gunakan dipakai juga
oleh orang lain, entah adik, kakak, atau rekan
sekerja. Untuk itu diperlukan kiat tertentu
untuk melindungi data. Salah satu yang dapat
anda proteksi adalah folder.

Setelah di depan diuraikan cara melindungi
folder dengan utilitas Folder Guard dan
dengan memodifikasi registry, berikut ini
adalah cara sederhana memproteksi folder
untuk mengamankan file-file tertentu agar
tidak bisa diakses lewat Windows Explorer.
Trik ini belum banyak diketahui oleh para
pengguna komputer.

KKIAIAT ST SEEDDEERRHANAHANA
MMEELILINNDDUUNNGGII
FFOOLDLDEER PR PRRIIBBADADII
Setelah menguraikan cara yang ‘agak rumit’ untuk melin-
dungi folder anda, Happy Chandraleka masih
mempunyai satu cara lain yang lebih sederhana dan dapat
anda praktikkan langsung.

S

AKSES LEWAT EXPLORER
Jalankan Windows Explorer
dengan mengklik kanan pada ikon
My Computer → Explore, kemudi-
an buka drive C:\ . Coba akses fol-
der _cakra. Akan tampil peringatan
bahwa folder tersebut tidak dapat
diakses. Anda hanya dapat mem-
bukanya lewat MS-DOS.

AKSES KE FOLDER _CAKRA
Kembali ke MS-DOS prompt. Pa-
da prompt C:\ ketikkan perintah
“cd _cakra.” Dengan _ berarti
karakter ALT+255. Setelah
menekan Enter anda dapat
masuk ke direktori _cakra.
Cobalah ketikkan perintah dir.

JALANKAN MS - DOS PROMPT
Pertama jalankan MS-DOS prompt
dari menu Start → Programs →
MS-DOS Prompt. Akan tampil
jendela MS-DOS Prompt dengan
direktori aktif C:\Windows. Ganti
direktori aktif ini dengan perintah
"CD\" dan tekan Enter.

MEMBUAT FOLDER DENGAN
ALT+255
Ketikkan pada prompt C:\ dengan
"md _cakra". Tanda (_) tersebut
berarti tekan tombol ALT (jangan
dilepas) ditambah tekan tombol
keypad (di kanan keyboard) 2,
kemudian 5, lalu 5. Akhiri dengan
menekan Enter.

1
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Melindungi folder lewat DOS Prompt

OPERASI FILE
Sebagai contoh operasi file - nya
ketikkan perintah “copy
c:\windows\forest.bmp c:\_cakra”.
Dilanjutkan dengan menekan
tombol Enter. Coba juga perintah
“move forest.bmp c:\mydocu~1” ,
dan tekan Enter. Tanda _ berarti
ALT+255.

6
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Untuk membuat suatu game komputer, anda tidak perlu menguasai secara mendalam bahasa
pemrograman seperti C++, Pascal, dan sebagainya.  David Sugianto mencoba menjelaskan cara

pemrograman game sederhana dengan Blitz Basic.

IKA ANDA SERING BERMAIN
game komputer seperti Age
of Empire, Quake III, dan

game-game populer yang lain,
pernahkah terlintas di benak anda
cara pembuatan game tersebut?
Banyak orang mengira untuk mem-
buat suatu game komputer adalah
sesuatu yang sangat mustahil, sebab
game tersebut hanya bisa dibuat oleh
orang yang benar-benar paham akan

pemrograman. Pendapat tersebut
tidak benar. Jika anda belum pernah
sama sekali terjun ke pemrograman,
dan anda ingin sekali membuat game
komputer, anda bisa melakukannya.
Dalam artikel ini, saya mengambil
contoh game yang akan dimodifikasi.
Game tersebut dapat anda temukan
di program Blitz Basic dengan meng-
klik menu Techniques > A simple
game. Anda akan melihat game

sederhana dimana kita sebagai
pengendara ship/kapal menembaki
musuh yang berada di atas layar.
Game tersebut akan kita modifikasi
agar terlihat lebih interaktif. Kita
akan menambahkan tulisan pengan-
tar dan pengenal game tersebut, dan
kita akan menambahkan latar bela-
kang berupa gambar bintang yang
bergerak.

Memodifikasi Game denganMemodifikasi Game dengan
Blitz BasicBlitz Basic

J

MEMBUKA BLITZ BASIC

Bukalah program Bilitz Basic anda.
Klik menu Start >  Program >Blitz
Basic > Blitz Basic. Lokasi ini bisa

berbeda di komputer anda

1 HALAMAN EDITOR

Ini merupakan halaman editor
tempat anda mengetikkan kode
program anda

3MEMBUAT FILE BARU

Setelah anda membuka Blitz Basic,
Klik File > New untuk membuka
halaman editor.

2

Menggunakan Blitz Basic

MMeenngggguunnaakkaann  BBlliittzz  BBaassiiccMMeenngggguunnaakkaann  BBlliittzz  BBaassiicc
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Berikut ini ialah listing program berikut dengan
penjelasannya:

AppTitle "Neoteker Ship"
Menandakan bahwa aplikasi yang kita buat bernama
“Neoteker Ship”.

Graphics 800, 600, 16, 1
Membuat layar menjadi mode grafik dengan ukuran
800X600, warna 16, dan 1 menandakan Full Screen.

SetBuffer BackBuffer()
Agar kita dapat menggunakan buffer ganda.

scroll_y=0:player_x=320:player_y=440
target_x=0:target_y=20:score=0
target_direction=1:bullet_x=0
bullet_y=0:bullet_fired=False
Semua nilai atau value yang akan kita gunakan disimpan
ke dalam variabel.

player=LoadImage("graphics\player.bmp")
bullet=LoadImage("graphics\bullet.bmp")
target=LoadImage("graphics\alien.bmp" )
backdrop=LoadImage("graphics\stars.bmp")
Menggunakan file gambar sebagai obyek game dan
disimpan ke masing-masing variabel.

While Not KeyHit(57)
Melakukan proses perulangan perintah di bawahnya
selama tidak ditekan tombol SPACEBAR.

TileBlock backdrop,0,scroll_y

Menyiapkan mode untuk gambar secara tile/memanjang

TileImage backdrop,9,scroll_y*2
menampilkan gambar secara tile, menentukan posisi x
awal, dan posisi y awal.

Color 240,50,5
Menentukan warna komponen merah, hijau, biru.
Masing-masing komponen dapat diset hingga ke nilai
255.

Text 330,50, "Selamat Datang"
Text 330,70, "      DI     "

Menampilkan teks di layar, posisi x, posisi y, kata yang
akan ditampilkan.

LokasiX1 = 200
Lokasiy1 = 200
For A=1 To 10
DrawImage player,LokasiX1,Lokasiy1
LokasiX1 = LokasiX1 + 40
Next
Text 330,250, " Neoteker Ship"
DrawImage bullet,210,250
DrawImage bullet,565,250
LokasiX = 200
Lokasiy = 280
For A=1 To 10
DrawImage player,LokasiX,Lokasiy
LokasiX = LokasiX + 40
Next
Color 255,255,2
Text 280,400,"Tekan SPACEBAR Untuk
Memulai"
Text 290,500,"Copyright NeoTek Corp."

Menampilkan nama game “Neoteker Ship” yang dike-
lilingi gambar. Bagian atas dan bawah berupa gambar
kapal kita, sedangkan bagian sampingnya berupa gambar
peluru dan menampilkan kalimat di bagian bawahnya
yang diserati dengan copyright.

scroll_y=scroll_y+1
If scroll_y=ImageHeight(backdrop) Then
scroll_y=0
Flip
Wend
menggulung gambar yang kita jadikan lata belakang agar
terkesan gambar tersebut bergerak.

Goto mulai

memanggil fungsi “mulai.”

.mulai
Membuat fungi “mulai”. perlu diingat, untuk
menyatakan bahwa ini adalah suatu fungsi, selalu diawali
dengan titik “.”.

Cls

Membersihkan layar.

While Not KeyDown(1)
TileBlock backdrop,0,scroll_y
Color 255,240,2
Text 10,580,"Tombol <- dan -> untuk
menggerakkan ship,"
Color 100,240,50
Text 370,580,"SPACEBAR untuk menembak,"
Color 200,200,255
Text 590,580,"ESC untuk keluar"
menampilkan gambar dan tulisan di layar seperti yang
telah dijelaskan sebelumnya.

If KeyDown(203)
player_x=player_x-4
If player_x<0 Then player_x=0
EndIf
Memeriksa apakah tombol yang ditekan adalah tombol
panah kiri. Jika ya, maka posisi kapal akan bergeser ke kiri
sesuai dengan isi variabel player_x.

If KeyDown(205)
player_x=player_x+4
If player_x>700 Then player_x=700
EndIf
Memeriksa apakah tombol yang ditekan adalah tombol
panah kanan. Jika iya, maka posisi ship akan bergeser ke
kanan sesuai dengan isi variabel player_x.

If KeyHit(57)
bullet_x=player_x+9
bullet_y=player_y-10
bullet_fired=True
EndIf

Jika tombol Spacebar ditekan, maka posisi peluru akan
tampil dan berubah.

target_x=target_x+target_direction
Mengupdate posisi target agar selalu berubah.

If target_x<0 Or target_x>700
target_direction=-target_direction
EndIf
agar posisi target jika sudah sampai di tepi layar, dapat
otomatis berbalik arah.
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If bullet_fired
bullet_y=bullet_y-4
memeriksa apakah ada peluru yang ditembakkan, jika ada
maka posisi peluru akan naik ke atas.

If bullet_y>0
If
ImagesCollide(bullet,bullet_x,bullet_y,0
,target,target_x,target_y,0 )
memeriksa apakah peluru mengenai target
Jika Kena Target:

score=score+100
target_x=0
target_direction=Abs(target_direction)
target_direction=target_direction+1
bullet_fired=False
EndIf
Score akan bertambah 100, target di reset ulang,
pergerakan target akan dipercepat, dan peluru di layar
akan hilang.
Jika Tidak Kena Target:

Else
score=score-20
bullet_fired=False
EndIf
EndIf

Score akan dikurangi sebanyak 20, dan gambar peluru

akan hilang dari layar.

scroll_y=scroll_y+1
If scroll_y=ImageHeight(backdrop) Then
scroll_y=0
DrawImage target,target_x,target_y

Memeriksa apakah nilai dari scroll_y yang telah ditambah
1 sama dengan tinggi dari gambar latar belakang, jika iya

If bullet_fired Then DrawImage
bullet,bullet_x,bullet_y
DrawImage player,player_x,player_y
Text 400,0,score,1
Flip
Wend
Return

Memeriksa apakah dapat ditampilkan peluru di layar, jika
ya, maka akan ditampilkan peluru dengan posisi sesuai
dengan isi variabel bullet_x, dan bullet_y, lalu akan tampil
isi score. Flip digunakan untuk swap untuk huruf dan
backbuffer yang kita gunakan di atas., perintah selan-
jutnya merupakan akhir dari fungsi “mulai.”

Untuk memberi gambaran lebih jelas kepada anda, di
bawah ini adalah tiga langkah untuk menjalankan game
yang anda telah modifikasi tersebut disertai dengan
ilustrasi. Sebagaimana telah diuraikan sejak awal, game
tersebut dijalankan lewat program Blitz Basic.

JALANKAN PROGRAM ANDA

Kini jalankan program anda dengan
mengklik Program > Run program

1 HASIL TAMPILAN GAME

Dalam tampilan ini terdapat tiga
objek dan beberapa tulisan berikut
score, dan petunjuk lainnya.

3TAMPILAN PENGANTAR GAME

Tampilan ini merupakan tampilan
awal dari game yang kita buat. Tekan
tombol Spacebar untuk memulai.

2

Menggunakan Blitz Basic

HHaassiill  AAkkhhiirr  GGaammee  HHaassiill  MMooddiiffiikkaassiiHHaassiill  AAkkhhiirr  GGaammee  HHaassiill  MMooddiiffiikkaassii

Selamat! Kini anda telah berhasil memodifikasi game
dengan sangat mudah. Jika anda kreatif, anda pun dapat
memodifikasi game ini atau game yang lain agar game
tersebut lebih menarik dan interaktif. Sebagai catatan,
game-game yang akan anda ubah harus dari source code-
nya. Anda tidak dapat memodifikasi game yang telah
menjadi file executable atau file yang dapat dijalankan
sendiri tanpa memerlukan program Blitz Basic.

Jika anda ingin mencoba game yang diuraikan di sini,
listing kodenya secara lengkap dapat anda peroleh di
www.neotek.co.id. Jika cukup rajin mencari, anda juga
bisa memperoleh source code lain dari banyak situs di
Internet, di antaranya di www.blitzcoder.com, www.
blitzprofessional.com, http://www.incitti.com/Blitz/, dan
masih banyak lagi. Kemahiran anda dalam memodifikasi
game pun akan bertambah dengan banyak berlatih.
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lash sekarang ini sudah
lazim kita jumpai pada
banyak halaman situ Web.

Pada nomor-nomor sebelumnya
NeoTek telah memperkenalkan pro-
gram pembuat flash yang mudah
yaitu SWiSH. Kali ini kami mem-
perkenalkan sebuah aplikasi yang
sama yaitu 3D Flash Animator yang
lebih cool. Aplikasi ini mempunyai
kelebihan yang hampir mirip
dengan Macromedia Flash. Dengan
program ini anda dapat membuat
animasi sampai membuat game ju-
ga. Pada kesempatan ini kami
mencoba memperkenalkan dasar-
dasar penggunaan program yang
amat menarik ini.

F

LEFT HAND TOOLS
Pilihan yang terdapat pada
sebelah kiri berfungsi untuk
mengerakkan objek, sheering
objects dan juga 3D move-
ment yang hanya aktif jika
anda membuat animasi
dalam 3 Dimensi.

4

10 11

5 6

12

STATUS BAR
Coba perhatikan status bar di
bagian paling bawah. Ini
menunjukkan letak kursor
dan objek anda beserta
warna RGBnya.

OBJECT PROPERTIES
Info mengenai properties se-
tiap objek sangat membantu
anda. Untuk membukanya
anda tinggal mengklik  se-
buah objek sebanyak dua kali
sehingga akan muncul
window Properties.

ZOOM
Ikon dibawah Interface adalah
ikon untuk Zoom (memper-
besar dan memperkecil ob-
jek) serta Time Line dan Loop
Function yang dapat anda
atur.

LINK & MEDIA
Di bawahnya terdapat Links
untuk membuka sebuah situs
bila movie diklik. Selanjutnya
pada bagian terakhir anda
dapat menambahkan image,
suara serta mengaturnya.

ELEMENTS & BACKGROUND
Geser ke bawah dan anda
akan mendapatkan Element
yang berguna untuk menam-
bahkan Action dan Event,
sedangkan Background tentu
saja untuk mengatur latar
belakang movie.

Perintah dan menu dasar pada ‘3D Flash Animator.’

MMEEMMPPEERRKKEENALKNALKANAN
3D F3D FLLAASSH ANH ANIIMAMATTOORR

3D Flash Animator adalah program pembuat flash dengan
kemampuan membuat bentuk tiga dimensi. Mempunyai
kemampuan mirip dengan Macromedia Flash, program ini
mudah digunakan namun memberi hasil yang memukau.
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HELP
Bila anda masih menjumpai
kesulitan atau banyak yang
anda ingin ketahui tentang
program ini, silakan membuka
panduan pada Help dan
membacanya.

CONTEXTUAL HELP
Fitur lain yang menarik adalah
panduan kontekstual yang
menjelaskan kegunaan pada
ikon. Untuk mengaktifkannya,
anda tinggal memilihnya pada
Menu Bar.

BASIC MOVIE
Sekarang buka movie baru
(Langkah 2), lalu pada window
sebelah kanan pilih interface
(Simple dan Advanced) serta
masukkan nama movie anda.

ADD ELEMENTS
Langkah selanjutnya adalah
klik Add Elements. Anda da-
pat memilih teks, gambar,
suara dan lainnya. Klik Title
Text karena kita akan men-
coba fungsi yang dasar lebih
dahulu.

TEXT OPTION
Setelah anda mengklik Title
Text, akan muncul window
baru. Masukkan kalimat yang
anda inginkan dan atur ben-
tuk dan besar font serta
warna yang anda inginkan.

BASIC EFFECTS
Setelah anda menutup layar
tadi, maka anda akan melihat
perubahan yang telah anda
lakukan. Berikutnya anda
dapat menambahkan efek
shadow pada teks anda.

1 2 3MULAI MEMBUAT
Untuk memulai sebuah
animasi anda tinggal memilih
File → New Project → New
Movie. Kemudian anda dapat
menentukan besar ukurannya,
frame rate dan warna latarnya.

INSTALLASI
Dapatkan dan instal program
ini dari CD NeoTek. Setelah
terinstal jalankan aplikasinya.

BROWSER TOOLS
Setelah anda mengklik Create
Flash Movie, maka akan
terbuka layar baru dan
membuka beberapa pilihan
baru untuk anda, seperti
terlihat pada browser.
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etelah diperkenalkan de-
ngan 3D Flash Animator
pada bagian sebelumnya,

kini saatnya mempraktikkan
pembuatan flash berbentuk 3D
lewat uraian langkah per langkah
berikut ini.

Bagian ini merupakan kelanjutan
dari bagian sebelumnya (Langkah
15 pada halaman 45). Di sini anda
dapat mempelajari cara menam-
bahkan efek yang lebih advanced
dan cara mengubah teks anda
menjadi animasi berbentuk 3
dimensi yang dapat digerakkan
sesuai dengan pengaturan yang
anda berikan.

S

ADVANCED
Selanjutnya scroll ke atas lagi
dan pilih Advanced Interface
pada bagian Interface. Untuk
membuka keyframe sebagai
langkah selanjutnya.

4

10 11

5 6
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KEYFRAME
Setelah terbuka toolbar untuk
keyframe, masukkan angka
untuk keyframe. Ini berguna
untuk menentukan lamanya
sebuah efek.

PLAY MOVIE
Selanjutnya scroll kembali ke
atas dan klik Play the Movie
untuk melihat hasil animasi
pertama anda.

3D SETTING
Selanjutnya masukkan
pengaturan pada properties
seperti Pixel Depth, Bevelled
dan Rounded sesuai dengan
selera dan keinginan anda.

PREVIEW
Selanjutnya klik Play the
Movie seperti di atas dan lihat
hasil animasi 3D anda. Bila
belum puas, anda dapat
mengubah aturannya lagi.

3D EFFECT
Anda dapat menambahkan
efek pada objek 3D anda,
seperti Rotate Title 3D yang
akan membuat objek tersebut
berputar searah dengan input
yang anda masukkan.

Membuat dan menyajikan animasi 3 dimensi

MMEEMMPPRRAKTAKTIIKKKKANAN
3D F3D FLLAASSH ANH ANIIMAMATTOORR

Ikuti sajian langkah per langkah untuk mempraktikkan
pembuatan animasi flash 3D untuk situs Web anda.
Caranya, seperti telah disinggung di muka, sederhana
sehingga anda mudah mengikutinya.
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3D TITLE
Untuk membuat judul dengan
bentuk 3D, anda dapat meng-
klik Add Element dan pilih 3D
Title. Element ini akan mem-
berikan atau mengubah objek
anda menjadi tampilan tiga
dimensi.

3D OBJECT
Berikutnya akan terbuka Pro-
perties dari 3D Title. Masuk-
kan teks anda dan title atau
judulnya serta pengaturan
lainnya.

3D VIEW
Setelah anda mengklik OK pa-
da Properties maka akan ter-
buka window yang terbagi 4;
pandangan dari arah atas,
samping, depan, dan bawah.

3D MODEL
Selain judul berbentuk 3D,
anda juga dapat memasukkan
model 3D seperti cube,
square dan lainnya. Klik Add
Element dan pilih 3D Model.

GEAR
Tools 3D lainnya dapat anda
temukan seperti Gear
Properties yang digunakan
untuk membuat sambungan-
sambungan dan lainnya.

PUBLISH
Setelah selesai semuanya an-
da dapat menyimpannya dan
kemudian melihatnya ditam-
pilkan dalam browser dengan
mengklik ikon berlambang
Internet Explorer.

1 2 3EVENTS
Klik Add Events dan pilih ping
elements untuk memberi efek
pada objek anda.

FLASH MOVIE
Anda dapat melanjutkan
praktik Langkah 15 pada
halaman 45 dengan  masuk
ke properties movie anda.
Kemudian scroll sampai ke
arah Events.

PREVIEW
Pada setiap efek yang anda pilih,
akan diberikan Preview dan peng-
aturan sendiri. Preview dapat anda
lihat pada bagian kanan bawah. 
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mulator untuk permainan
pada konsol seperti Super
Nintendo, Sega dan Play

Station sudah dapat anda temukan
dimana-mana dan dapat dimainkan
pada komputer anda. Semua  terse-
dia gratis dan dapat anda download
dari Internet. Di sini akan dibahas
dua emulator untuk konsol Play
Station, yaitu Connectix Virtual
Game Station dan EPSXE buatan
para pecinta emulator. VGS dihenti-
kan pengembangannya karena Con-
nectix membuat emulator ini untuk
dijual sedangkan EPSXE diberikan
secara gratis. Kita akan melihat cara
menggunakan kedua emulator ini
dan apa perbedaannya.

KKOOMMPPUUTTEER SR SEEBBAAGGAIAI
PPLLAAYYSSTTAATTIIOON EN EMMUULLAATTOORR

Dengan Virtual Game Station (VGS) dan EPSXE anda dapat
memainkan game console terkenal pada PC anda. Ikuti cara
penginstalan dan penyetelan kedua emulator ini.

E

CONTROLLER SETUP
Klik Setup Controller. Di sini
anda dapat memasukkan key
yang memudahkan anda untuk
memainkan permainan. Bila
anda mempunyai Joystick PS
anda tinggal mengaturnya.

INSERT CD
Selanjutnya masukkan CD
Playstation kedalam CD-Rom
anda dan VGS secara otomatis
akan me-load game tersebut.

VGS 1.4
Anda dapat mencari VGS pada
www.google.com dengan
keyword VGS+Crack, atau
tinggal anda salin dari CD
NeoTek.

VGS SHORTCUT
Kemudian setelah anda me-
nyimpan VGS pada harddisk
anda, buat shortcut agar
mudah dibuka. Klik kanan
pada desktop dan pilih New →
Shortcut.

1

4 5

2

Membuat PC anda menjadi konsol game.

KONFIGURASI
Klik ikon VGS dan kemudian
pilih Edit → Preferences. Di sini
anda dapat mengatur kontrol
yang akan digunakan, mem-
buat memory card, dan
mengatur movie, brightness
dan sound.

GRAPHICS DETAIL
Pada saat game dimainkan
VGS akan mengatur tampilan
grafik game sesuai dengan
kemampuan VGA card kom-
puter anda. Semakin bagus
card anda, maka semakin halus
tampilannya.

3

6
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SETUP CONTROLLER
Selanjutnya klik Config → Pad
untuk memasukkan Key pada
keyboard untuk pengaturan
kontrol permainan. Jika anda
mempunyai Joystick PS bisa
anda gunakan pula.

DOS GUI
EPSXE masih menggunakan
DOS Engine sebagai alat dalam
menjalankan suatu CD dan
perintahnya.

EPSXE 1.5.1
Versi terbaru dari EPSXE dapat
anda download dari www.
epsxe.com atau anda dapat
jalankan dari CD NeoTek. Instal
program ini ke dalam PC anda.   

CONFIG
Pertama kali anda menjalankan
EPSXE maka akan muncul
Wizard Config. Config ini untuk
mengatur BIOS dan Plugins
yang akan anda gunakan.

1

4 5

2 MEMORY CARD
Selanjutnya anda dapat
membuat atau memilih
memory card yang akan anda
gunakan. Pilih Config →
Memory Card.

GRAPHICS DETAIL
Kehalusan dari EPSXE tergan-
tung dari VGA Card anda juga
namun dapat dioptimalkan
dengan plugin yang dinamakan
GPU. Selamat bermain.

3
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Iklan VisionNet (Berwarna)
17,6 x 12,3 cm




